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The idea of TUX is about two years old. In those
two years, we have proved that:

� Linux is ready for the desktop.

� People using or wanting to use desktop Linux
are ready for TUX.

Our initial vision was to bring useful how-to
information to the new Linux user. If anything,
that readership vision has expanded to include
people who, although they may have used Linux,
are new to desktop Linux and/or are new to 
using a graphical user interface with Linux on 
the desktop.

The vision for TUX comes from what I have
learned while publishing Linux Journal and from
more than ten years of using Linux as my only
desktop. In addition, although I have used an
assortment of graphical user interfaces, the offi-
cial company desktop has been KDE-based for
about eight years. KDE was just a baby back then,
but I felt it was the future of the Linux desktop.

I have decided that I need to invest more time
in making sure TUX is on-track with the vision.
Those eight years of bringing newcomers to Linux
and KDE can now be used to help TUX readers
get up to speed with desktop Linux.

In addition, I know that although TUX is very
inexpensive, the fact that we are now charging
for subscriptions will raise subscriber expecta-
tions. I intend to make sure you are not disap-
pointed. In fact, the first item on our list was to
get a search feature for magazine back issues up
on the TUX Web site. You can find that feature
by clicking on the Search Back Issues link below
the current cover on the left column of the 
http://tuxmagazine.com Web site.

To help us move forward, I have asked Tony
Mobily to join the TUX team as Editor. Tony is a
computer consultant, journalist and Zen Buddhist.
He lives in Australia, working as a magazine editor
and consultant. Tony has been an active member
of the Open Source movement for many years. In
2004, Tony founded Free Software Magazine
(http://www.freesoftwaremagazine.com), a popu-
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lar publication about free and open-source software. He is
also the author of the book Hardening Apache and several
articles about Linux and open-source software.

Tony initially will take on working with authors to secure
quality how-to articles for TUX and make sure that we are
addressing readers’ questions and concerns. Beyond that,
Tony and I will be working with the rest of the staff to make
TUX bigger and better in the future.

We are currently putting the final touches on the 2007
editorial calendar. Although each issue of TUX will continue
to have a focus, we want to make sure that each issue also
has broad appeal for our readers. We will, of course, have
the Distribution Smackdown issue and the TUX Awards issue
again next year. Stay tuned.

Moving on to Linux and the world outside TUX, I often
like to take a look at generic world news and see if Linux
appears in it. I did that today and was surprised. In the past,
a typical Linux article has been about a city, state or country
deciding to convert to Linux and/or open-source software.

This time, the first article I found was from The Independent,
a UK-based newspaper (http://news.independent.co.uk). In the
article titled “The Ten Best: Software Packages”, I was surprised
to see Novell SUSE Linux 10.0 at number four. As 10.1 has been
available for quite a while now, it was far from earth-shattering

news, but it was a surprise to see it on that list.
Next, I was led somewhat indirectly to the Public

Technology Web site (http://www.publictechnology.net)
through another UK newspaper. This time, it was about the
282 schools in Oxfordshire county getting Linux-based servers
to connect them to the Internet. This news deals with servers
rather than desktops, so it is less interesting to TUX, but it’s
another Linux win.

A third article is from PRNewsWire titled “Augmentix(TM)
Announces Deployment of 12,000 Units of Its Server Availability
Management Processor to a Fortune 50 Corporation”. We don’t
know who that Fortune 50 corporation is, but there are proba-
bly not that many telecom giants in the Fortune 50. The inter-
esting part here is that Augmentix uses a Linux kernel in its 
system that monitors other systems and reports failures.

We have desktop Linux, server Linux and embedded Linux
all appearing in today’s (September 6, 2006) world news.
There were many more articles—some in languages about
which I didn’t have a clue. My search, by the way, was done
by going to http://www.wn.com, searching for Linux and
sorting by date. I found 92 articles. Nice to see how Linux
World Domination is progressing.�

Phil Hughes is Group Publisher for SSC Media Corp.
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FROM THE EDITOR

Greetings from TUX’s New Editor!
It’s an honor to be here, creating this fantastic magazine and helping Linux win the desktop war.

When I was offered the position of TUX editor, I felt very privi-
leged. I had been reading TUX since issue 1 and had a really
strong deja-vu feeling. Many years ago, when Linux Journal
started, nobody believed that Linux could possibly end up on
mission-critical servers doing “real” things. I knew they were
wrong; Phil, the founder of SSC, knew it as well and founded
Linux Journal. The “Linux people” were the minority, and most
people would have told you that the future was either UNIX
(the real thing, you know: AIX, Irix and so on) or Windows NT.
Well it turned out that we, the “Linux people”, were right.
Linux is not big; it’s huge in the server world. We (myself,
Phil and a few more thousand people) knew it would make
it. And it did.

Fast-forward more or less a decade: history is repeating
itself. Now, the issue is the desktop, more than the server space
(which is a war Linux has won already). Here we are, again:
myself, Phil and a few...well, a few million people this time,
who believe that Linux is absolutely ready for the desktop.
Unfortunately, quite a few people out there don’t seem to
believe us. We know we are right. Phil, the founder of SSC,
started TUX. Does it sound like a familiar story?

It’s very exciting, because it’s now 2006 and the world is dif-
ferent. Two years ago, SSC didn’t create a paper magazine but

an electronic one. SSC also made the bold step of charging for
electronic subscriptions, in order to be sure we will never ever
need to sacrifice TUX’s quality. This time, it’s different—at least
for me. When Linux Journal started, I was a spectator; this
time, I get to sit in the editor’s chair. This is really quite a privi-
lege for me. I am reading your letters and taking your pieces of
advice very seriously. For example, we will soon talk about how
to make your Linux system more secure and how to get your
hardware to work right in Linux (two popular topics). I will do
whatever I can to listen to your advice and make sure that TUX
establishes itself as the best magazine for you: the desktop
Linux users.

I WILL DO WHATEVER I CAN TO LISTEN

TO YOUR ADVICE AND MAKE SURE

THAT TUX ESTABLISHES ITSELF AS

THE BEST MAGAZINE FOR YOU: THE

DESKTOP LINUX USERS.

TONY MOBILY
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So, here I am, introducing issue 18 of TUX magazine.
This month’s focus is on e-mail. To me, e-mail is where

“everything started”. Back in 1993, the Internet was a much
lonelier place than it is now. There was no Web yet, and non-
academics were only just starting to use it. Connecting was
expensive, and the speed was laughable—a tiny fraction of the
20Mb I have in my own home today. A few people shared infor-
mation using Gopher or FTP (!). So, e-mail and newsgroups
were the most-used and most-viable Internet services.

Some 13 years later, the Internet has changed a lot. Something
called the World Wide Web emerged (anybody heard of it?) and
yet e-mail still seemed to grow very strong. However, even e-mail
has evolved. People want to be able to encrypt their e-mail using
their private keys.

Mitch Frazier, in his article “Installing Enigmail in
Thunderbird”, tells you exactly how to do that. After read-
ing his article, you will be able to send e-mail to your peers
and be certain that nobody will ever be able to read it—
unless you let them. For those lucky people who want to get
away from Windows and keep their e-mail, Donald Emmack
explains how to transfer your messages from Outlook to
KMail. Importing existing data is crucial when you switch
operating systems. In his article, Donald explains exactly
what to do to use KMail’s powerful importing features.
Finally, Dmitri Popov explains how to categorize your e-mail
in folders and virtual folders using Thunderbird, so that you
will never lose an e-mail message again.

This issue of TUX is not only about e-mail.
Donald Emmack wrote two other articles, one on Akregator

and one on SuperKaramba. Akregator is a powerful RSS reader; it
allows you to keep an eye on your favourite RSS feeds through its
sleek interface. SuperKaramba, on the other hand, is a completely
different story: it lets you create the coolest desktop possible.
Read the article to find out how. They are obviously very different
programs. I will leave it up to you to decide which one is most
useful (I love them both). Phil Hughes explains how to
“Download, Burn and Boot an ISO” (which is also the article’s
title) in the easiest possible way. The article shows, once again,
that Linux is indeed ready for the desktop, as it allows you to
complete everyday operations with a few mouse clicks. Jay
Kruizenga wrote a great article on Opera 9 for Linux. Opera is a
fantastic Web browser that many people prefer to the legendary
Firefox. If you want to know why, read on. Finally, Jes Hall threat-
ens your wallet with a review of the Acer Aspire 3620, and Jay
Kruizenga threatens your marriage and available free time with a
fantastic Linux game: Postal 2: Share the Pain.

I hope you will enjoy reading this issue of TUX as much as
we enjoyed making it. I will see you next month.�

Tony Mobily (BSc) is a computer consultant, journalist and Zen Buddhist. 
He lives in Australia working as a magazine editor and consultant. Tony has
been an active member of the Open Source movement for many years. In
2004, he founded Free Software Magazine, a popular publication about
free and open-source software. He is also the author of the book Hardening
Apache and several articles about Linux and open-source software.
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Covering New Games
I’m glad to see an issue devoted to gaming in Linux; however, I
was a little bit disappointed with the overall coverage. I consider
myself a hard-core gamer and use Linux exclusively at home. I
regularly play World of Warcraft, Guild Wars, Neverwinter
Nights, America’s Army and others while using Teamspeak for
in-game communication with teammates. I use a mixture of
native Linux software and Cedega to achieve this. I have to say,
seeing games like Max Payne (2001) and Tomb Raider (1996)
didn’t go a long way toward convincing serious gamers that
Linux is ready for gaming, when it really is! For instance, the
article about Gorky 17 doesn’t mention that it was a game that
was originally released in 1999 for Windows under the name
Odium. I am glad to see Quake 3 and Doom 3 showcased, but
also showcasing more than seven-year-old games isn’t likely to
gravitate newer, younger gamers toward Linux. Don’t get me
wrong, I still want to see more developers releasing native
games for Linux, but in the meantime, that isn’t stopping me
from being able to play everything I want right now!
--
Evan Thomson

Xandros Needs Activation!
I am a newbie to Linux and have only recently subscribed to
TUX. Its nontechnical focus is appropriate for me as I do not
make my living in the computer field. I have dabbled with
Xandros 3. When Xandros 4 was announced, I was happy to
upgrade for all the reasons listed in the review in the September
2006 issue of TUX. Although I agree with all the positive things
the reviewer writes about Xandros, there is no mention of one
significant negative, which had I known before I upgraded, I

likely would not have. To wit, Xandros 4 requires activation in
the same sense that MS products do. However, the Xandros
scheme is very much worse than that implemented by MS.
Xandros update will not work until activated; if you have a prob-
lem with the activation, which must be done on-line, it may
take days to sort it out. I had to wait five days before my issue
was resolved by e-mail, and according to the Xandros forums,
my experience is not unusual. At least MS has 24/7 support for
activation problems.

Not including this fact in the Xandros review is a disservice to
your readers. As long as your readers know that Xandros 4
requires activation before they buy it, they can make up their
own minds whether activation in a Linux distribution is a deal-
breaker or not.
--
Rob Solomon

Quake 3 Still Available
Your September 2006 article on Quake 3 mentioned that Loki,
the Linux Quake 3 distributor, has gone bankrupt. Fortunately,
there is another way to get Quake 3 on Linux. Go to
http://icculus.org/quake3, and there’s a project that takes the
Quake 3 source code, fixes bugs, enhances it and puts it up for
download. All you need to do is copy the pak0.pk3 file from
your Quake 3 CD to the baseq3 directory on your computer
after running the installer scripts, and you’re good to go!
--
Brian

Thanks for your tip, Brian!—Ed.

LETTERS

http://icculus.org/quake3
http://www.tuxmagazine.com
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Where Is Mango?
I have been a reader of TUX since the first issue, and I wonder
what happened to Mango, who gave some of the most sensible
advice? Why was there no mention of her absence in the
September 2006 issue? If such unexplained disappearances are
what may happen in the paid edition, I am going to have to
think very hard indeed.
--
James Silverton

Another Mango Fan Is Concerned
I look forward to receiving my copy of TUX each month in antic-
ipation of Mango’s Q&A piece. It seems to be missing in the
September 2006 issue—what’s up with that?
--
Wolf Pusztay

And Another...
I just received the September 2006 issue of TUX. I always appre-
ciate the information given in your magazine. One thing that
caught my eye was the missing Q&A with Mango Parfait sec-
tion. This is one of my favorite parts of your magazine!

I take it that Mango Parfait is on vacation. It would be a big loss
to the character of this magazine if she didn’t write in it any-
more. The reason for this is the information given by her is very
funny and sarcastic. Although the rest of magazine is still very
good, I thought she gave the dot to the i.
--
Reinhard Matheis

And Another...
I noticed that there is no Mango Parfait column in the
September 2006 issue. I hope this does not mean you have dis-

continued her feature.

I find her to be both knowledgeable and entertaining. Don’t let
her critics deter you. If they don’t like it, they can skip over it—
no one is making them read it. But, if they get their wish and
have her removed, they are preventing me from reading her
work. Does that sound free or open?

I have been using Linux for more than three years (Mepis, Ubuntu
and Kubuntu now), although to some extent I will always be a
newbie. Keep up the good work on your excellent magazine. It is
definitely worth it to me to be a paying customer now.
--
Jamie Miller

And Another...
Where was Mango Parfait in the latest TUX? Did she demand a
raise and get the boot? Did she leave Otaku and marry an
armadillo as her friend Bunny suggested in August?

That must be it! She married an armadillo and they are on their
honeymoon! That can’t be a good combination. Can you imag-
ine Mango having little scaly (but nonetheless beautiful and
intelligent) four-legged children?
--
Richard Craver

Fear not, James, Reinhard, Jamie, Wolf: Mango was on tempo-
rary leave, and she is now back! Richard: how how on earth did
you know....No, let’s not talk about it!—Ed.

Doom Tip
Initially, I had issues with sound when I was playing Doom 3
because I had only two speakers and it was expecting 5.1

http://www.tuxmagazine.com
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surround sound, so I thought I might share my solution.

The following arguments appended to the doom3 command
fixed the problem:

doom3 +set s_numberOfSpeakers 2 +set s_driver oss

--
Jason Howard

Thanks a lot Jason!—Ed.

A Whole Bunch of Observations
I’m a Linux newbie who’s three months in with a whole bunch
of questions and observations that I would like to share with
you and your readers. First up, what is it with Linux people who
feel they have to bash Microsoft at every given opportunity?
Without a simple and easy-to-use operating system, computers
would not be as popular as they are today. No matter what your
feelings about the business models, pricing strategies and so
forth of Gates and Co., it’s hard to deny that they have helped
spread the use of computers. They may not have gotten every-
thing right, but without them, would we be as far along as we
are today? Members of the Linux community should be bigger
than that. Our products (I know I haven’t contributed yet,
but it is a group effort after all) should stand up and speak
for themselves.

Secondly, I have something to say on the whole issue of “free”
software. I love free things; I think they are great. But, if I have
to pay for something, I will, as long as I feel it’s worth the
money I am asked to pay for it. There seems to be far too many
people that expect everything to be given to them for free just
because it’s on a computer. Perhaps because it’s not a physical
thing, they struggle to justify the expense. In that case, I say

“don’t”. Don’t buy it. If you want it, but you feel it’s not worth
the money, then don’t buy it, but don’t feel you have to tell me
and the whole world how unfair it is that you have to pay for
something. You don’t go to grocery store and expect to walk
out with sack-loads of food for nothing, do you? Maybe you do,
and that brings me on to the next point.

If you’ve been running a cracked copy of XP for the last five
years, don’t come crying to me about how you now have an
annoying pop-up that politely informs you that you “may” have
been the victim of counterfeiting. I can’t help you, but I think
“Gotcha” may be a more appropriate message, or maybe the
warmer “come along now, you’ve had a good run with your
dodgy copy, time to pay up”. I, for one, think Microsoft should
switch off all illegal copies of XP with a simple “this copy of
Windows is not a legal copy; if you choose not to activate your
product legally, your computer will now shut down”.

I read in a lot of the letters that people are complaining that this
device or that device doesn’t work straight out of the box with
Linux. Well, boo hoo. As has been pointed out many times,
things were once the same way for Windows. Remember the
time before plug and pray? Give it a chance people. Windows
has a whole bunch of highly organised years under its belt,
while Linux is still a collection of distributions scrambling to get
a footing. Use the forums, and most important, don’t be fright-
ened and don’t be lazy. You’ve installed Linux once. If you screw
things up really bad, you can always do it again. Only next time,
try another flavour. Worst case—put in some effort and learn
how to solve the problem yourself rather than relying on some-
body else to do the work for you. Some distros recognise some
hardware better than others—actually, strike that. They don’t
necessarily recognise it better, different distros just recognise dif-
ferent hardware. If in doubt, download a bunch of live ones and

http://www.tuxmagazine.com
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see which fits best. I run PCLinux on an old HP laptop, solely
because it detects and configures my USB Wi-Fi adapter auto-
matically. Alas, the same can’t be said for my main laptop,
which has a built-in Wi-Fi adapter, which is proving more elu-
sive. Note to distro creators: work harder on getting wireless
support built in to your releases. Note to hardware manufactur-
ers: save the story about protecting your design integrity—do
you have any idea how popular Linux in all its flavours is becom-
ing? Think ahead people!

Like I said, I have only just stumbled across your magazine and
subscribed right away, so I’m busy trawling through the back
issues and trying to get caught up to issue 16. One thing I do
notice, certainly in the earlier issues and forgive me if this has
been addressed and rectified in later issues, is that there is a
huge bias toward KDE over and above other desktop environ-
ments. This is something I don’t understand. To me, Linux is all
about choice. The choice to run any one of a whole host of e-
mail clients, Web browsers, office suites and, yes, even desk-
tops. To tout one desktop blatantly over all the others is most
unfair to people who are less than impressed with KDE. Maybe
it’s too Windows-esque—I like the minimalist feel of Xfce, and
there’s just something about GNOME that I like, but I feel left
out because of your KDE bias. The desktop is the place where it
all starts, where you launch your programs and from where you
configure a whole bunch of stuff. No matter how good a distro
is or how much hardware it picks up automatically, if I can’t get
on with the desktop, I won’t stay with it for long. I may install it
initially for that functionality, but I will always be looking for a
GNOME or Xfce version. Why not have articles featuring the
same subject but for each of the main desktops available? You
don’t have to run them all in the same issue, but if I don’t run
KDE, most of the media management articles in your first issue
are of no use to me.

Finally, I sometimes feel for a magazine aimed at beginners you
assume too much knowledge. How about some articles that tell
people how to partition their disk during installation, or better a
still, a complete installation walk-through in each of the major
formats. A regular how-to on central issues like setting up a
home network or even a small business network, wireless net-
working, printing, downloading and extracting tarballs, not to
mention sidebars with explanations of what tarballs are and
how to tell if you are running a terminal as a user or as root?

Despite everything I’ve said, I think your magazine is within sight
of greatness. Keep it up.
--
Andrew Hawkins

About this question: “without them [Microsoft] would we be as
far along as we are today?” Who knows? My gut feeling is that
without Microsoft we would be much, much further. But
nobody actually knows. Windows bashing is undeniably happen-
ing, and that’s very normal when there are two factions com-
peting against each other! About “buying” software, it’s always
a matter of freedom: you are free to buy Windows XP; you are
free to use a cracked version and hope that nobody will ever
knock on your door; or, you are free to use open-source soft-
ware. The problem, in the case of XP, is that if Microsoft doesn’t
allow cracked versions of Windows to be patched, the world
quickly will be full of spam bots and viruses, which basically will
take over the Internet. Microsoft can’t afford that. The Internet
can’t afford that. About hardware support: distributions have
only a very small part of the blame. There is still hardware out
there that is not supported (see Broadcom Wi-Fi cards, for
example), and that’s the real issue. Thanks for your pieces of
advice about topics—we’ll keep them in mind!—Ed.

http://www.tuxmagazine.com
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Advice for Success
I like the format of your magazine and do not mind that it’s
moving to paid subscription. I would like to share a few com-
ments as I want the magazine to be successful. I would like to
see more of the following:

� Hardware column: how to get popular hardware items to
work with Linux like Webcams, digital cameras, printers and
so on.

� Software column: the latest and best software available,
including commercial software and a consistent review 
standard.

� Security column: covering topics in plain English about firewalls,
antivirus programs, securing Linux, backing up and restoring.

� Programming column: simple stuff, like how can I write a
basic script, or show me how to create a small program and
compile it. Not just the steps, but explain what each step
does. Most important, this column could be used to help peo-
ple become more comfortable with the terminal.

I myself would like to see a magazine kind of like the PC maga-
zines I read in the 1980s. They were helpful, had little program-
ming sections to teach concepts and had articles on DOS com-
mands and batch files that you could create to take care of sim-
ple tasks and were great at teaching me DOS.

Above all, keep it geared to the Linux desktop user and not nec-
essarily the Linux server admin. I hope the magazine is successful!
--
Michael

Thanks a lot Michael! I think you gave us great advice. When
you see those things happen in TUX, you can show this letter
to your friends and family and say, “You see, they did exactly
what I told them to do!”—Ed.

Big Migration Problem
Thank you for TUX, a useful resource that I recommend to all
I deal with in the course of my work. As to my work—I hang
my shingle out as a Linux consultant helping individuals and
businesses migrate from Windows. As I’ve been a Linux user
since 1992, you could regard me as something of an expert.
Notwithstanding, I still feel like a novice in many regards—
Linux being so deep.

The largest issue I face in helping businesses migrate to Linux
is a lack of fully featured accounting, payroll and production
software that is written for Linux from the ground up and
that is not:

� Like Nolapro, which is PHP-driven.

� Like Jade or Oracle, that support only large user bases.

� Kludges, like others that require the installation of Wine or
VMware.

� Hard to use and not fully featured, like GnuCash.

And, I’m hoping for something that is similar to M.Y.O.B or
QuickBooks. I’ve even written to vendors, offering to help
cross-compile their code so it can run natively on Linux.
Alas, none have accepted the offer. Notwithstanding, cross-
compilation being less demanding and so requiring less staff
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resources than building such applications from the ground
up that would then entail significant outlays of capital, I am
just not in a position to consider embarking on the creation
of accounting and payroll software at any time now or in
the future.

Surely there is a solution out there. Perhaps there is not. I have
so many prospects for migration to Linux pending this seemingly
intractable problem.
--
Peter E. Lowrie

Follow-Up Letter
Thanks for the detailed reply to my woes [see the September
2006 Letters]. Although I agree that I cannot expect the com-
munity to rise to help me in all my problems, at least I hope to
be guided in the proper direction to help myself by digging
deeper. The problem of costly and slow Internet connections in
India remains. By the way, I have changed my hardware now
and have AMD Athlon 64 with an Asus motherboard with built-
in sound and video and have installed Ubuntu 64-bit. Thanks to
the Mango Parfait column, I was able to solve the non-connec-
tion to the Internet problem (NVIDIA card and Windows—the
system must be powered off and booted into Linux for the
Ethernet connection to work). Thanks for the excellent maga-
zine; I find this to be more useful than trying to search the
forums for solutions.
--
Srinivas Murthy

No worries at all—thank you for your letter!—Ed.�

SEND LETTERS TO THE EDITOR TO 
EDITOR@TUXMAGAZINE.COM.

mailto:editor@tuxmagazine.com
http://shoprcubed.com
http://www.tuxmagazine.com
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I know you missed me last month, but a
girl needs a vacation sometimes. I spent
two weeks visiting friends in many
places. I had much fun in all the places,
but I think I had the most fun visiting my
friends on the Kappa Mikey Nickelodeon
show. I know all the stars on the show.
Well, I do not know Mikey very well, but
I know Lily, Mitsuki, Guano and Gonard
very well. Some people think Lily is my
sister because we look alike. We are not
sisters. They say we act alike too, but we
do not. We are very different. Lily thinks
she is a diva. I am a diva. Another thing
is Lily is not a genius and she does not
know Linux. I like Lily, but I like Mitsuki
and Gonard more. I hope Lily does not
read this. I do not want her to feel bad
because I like her friends better. I want
her to feel bad because her friends like
me better.

I know a secret about Guano, and I
will tell you if you promise not to tell
anyone else. He does not look like the
character on the show. He is really an
actor wearing a costume. And his real

name is not the silly name Guano. His
real name is Feces. I think they changed
it because Feces sounds too much like a
Greek name.

My boyfriend Otaku did not come
with me on vacation. He says I spend too
much time talking girl talk with my
friends when we visit them. I was mad at
Otaku, so I broke his KDE before I left. I
know he can fix things, but I know he is
too lazy. So he had to use GNOME the
whole time I was away!

Okay, I will answer your questions
now. Thank you for sending me good
questions. I will start with an old ques-
tion, because I have a new answer.

Q My network stops working in Linux
sometimes after I have been using

Windows and then boot to Linux.

A Here is my old answer. Sometimes
Windows does something to the

network card that makes it stop working
in Linux. Sometimes you have to shut off
your computer and unplug it to reset the

network card.
I found out that this does not happen

very much. This is what happens more. It
is a problem that happens a lot on
Ubuntu and Kubuntu.

Some computers have two network
cards built into the motherboard. You
probably use only one of them.
Sometimes Linux makes a mistake and
changes the device names for the net-
work cards. First it makes the one you
use eth2, and the next time you boot, it
makes the same card eth3. I give these
examples because Linux sometimes
thinks the network cards are eth2 and
eth3, even if you have only two network
cards. This does not make sense, but it is
true. It should see the two cards as eth0
and eth1 even if it confuses them, but it
doesn’t always do that. Sometimes it
sees them as eth2 and eth3.

Say your computer sees them as eth2
and eth3. You configure eth2. The next
time you boot it thinks the same card is
eth3. Now your network does not work,
because it sets up the card that does not

Mango returns from vacation, reconsiders an old question, gives advice on loading kernel modules and more.
MANGO PARFAIT

Q&A with Mango Parfait
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have a cable connection. This is why your
network stops working.

If you know how to change your BIOS
settings, you may be able to disable one
of the network cards. This fixes the prob-
lem sometimes.

Here is another way to fix the prob-
lem. Configure eth2 and eth3 to be the
same. I assume your computer is using
eth2 and eth3. If it is using two other
device names, like eth0 and eth1, config-
ure them the same, but my example is
eth2 and eth3.

Install the package called ifplugd with
the command:

$ sudo apt-get install ifplugd

You must edit a system configuration
file now. Do a command like the following.
(I use gedit in my example because this
happens on Ubuntu many times. You can
use your favorite editor instead of gedit.)

$ sudo gedit /etc/default/ifplugd

Look in the file and find this:

INTERFACES=""
HOTPLUG_INTERFACES=""
ARGS="-q -f -u0 -d10 -w -I"
SUSPEND_ACTION="stop"

Change the INTERFACES line so that it
looks like this:

INTERFACES="eth2 eth3"

I GIVE THESE EXAMPLES

BECAUSE LINUX SOMETIMES

THINKS THE NETWORK

CARDS ARE ETH2 AND ETH3,

EVEN IF YOU HAVE ONLY

TWO NETWORK CARDS. THIS

DOES NOT MAKE SENSE,

BUT IT IS TRUE.

ifplugd will look for a cable on eth2
and eth3. It will configure the interface
that has a cable connected. You have
only one cable connected. It does not
matter if Linux thinks it is eth2 or eth3.
ifplugd will configure the one that has
a cable, so maybe one time it will con-
figure eth2 and the next time it will
configure eth3. It does not matter. Now

you should have a network that works
every time you boot. This will stop
working if you disable one of the 
network cards. So do not do that.

Q I am a devoted Mango Parfait fan
and hope you can help me with a

question about loading kernel modules at
boot time. I have a Dell Optiplex GX1 run-
ning Fedora Core 5, but Fedora does not
recognize the built-in sound card. I can
load the kernel module with the command
modprobe snd-cs4236, and the sound
works like it should. But, when I reboot, I
am back to having no sound until I type in
the command again. Rather than type in
this command each time I reboot, how can
I get the kernel module to load at boot
time? I suspect I will have to modify
/etc/modules.conf, but playing chicken
with unfamiliar configuration files gives
me kernel panic. Thank you—Paul

A I like your joke! “Playing chicken”
is funny! No, I am kidding. I know

your joke is “gives me kernel panic”,
and it is very funny!

I cannot test this, because I do not
have a Dell Optiplex GX1. But, I think 
I know how you need to fix this. You
need to play chicken with the file
/etc/modprobe.conf. You need to edit
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this file as the root user. You know
how to insert the module, so I think
you know how to edit a file as root.
For funsies, I will say you are using the
vi editor. Here is what you do:

$ su -
(enter root password)
# vi /etc/modprobe.conf

You will see something like this (you
may have many lines, but I show only
one here):

alias eth0 e100

Add a line so it looks more like this:

alias eth0 e100
alias snd-card-0 snd-cs4236

Save this file. Fedora should load the
sound module every time you boot.

Q I am limited to a dial-up connection,
and I have a small mixed home net-

work (Lin/Win). My modem server allows
all clients to use the Internet. It runs Red
Hat 6.0 with ipchains (firewall), diald (to
control the phone line) and dialmon (serv-
er to allow clients to control diald on the
server). Yes, I know it is old (like me).

My main Linux client is Red Hat 9.0 on

fairly current hardware. I want to upgrade
my client to a more recent distribution;
however, Red Hat 9.0 is the most recent
distro I can find that includes the software
required by the dialmon client (needed to
control the modem status).

When I try to run the dialmon client
program from newer distros, I get error
messages saying that wish is not found on
my system. Looking for wish files reveals
that Red Hat 9.0 includes wish8.3. It is not
in its own RPM, and I have not found any
valid references to it on the Internet. It
does not appear to be a part of the
Fedora Core 4 distro either. After copying
the /sbin/wish8.3 file to the Fedora install,
I get the same error message.

Can you tell me how to find wish and
install it on Fedora or Ubuntu or another
distro, or can you recommend a replace-
ment for diald and dialmon?

It’s beginning to look as though 
the whole world has gone to high-speed
connections and doesn’t need this 
stuff anymore! I’m being left behind!—
Harry Bump

A I think my great, great grandfather
told me about diald when I was a

little girl. He is not my father’s father’s
father’s father. He is only my grandfather.
But he is very great.

I do not know if the new diald will

work with dialmon. I think it uses a
new program called dctrl. But I do not
think that is your problem. I think you
are going to keep using the old diald
on your modem server, so you can still
use dialmon.

You need to get Tcl/Tk to get your
wish; wish is part of the Tk package. I
think the latest versions of Tcl and Tk are
both 8.4. I do not know if 8.4 will work
for you. Maybe you will need 8.3 like
your old Red Hat uses. Do not worry. That
is okay. Most Linux distributions still have
Tk8.3 packages. If you use Ubuntu or
Kubuntu, do this command:

$ sudo apt-get install tcl8.3 tk8.3

You can use the Adept package
manager or Synaptic, or any other
package manager if you do not want
to type commands. The wish8.3 file is
in the package tk8.3, not tcl8.3. Maybe
you need only tk8.3 and do not need
tcl8.3. I do not know. I would test the
programs to find out for you, but I
would have to buy a dial-up modem. I
do not think I could find one in a store,
because I do not know what one looks
like. So I think you should try to install
tk8.3 and see if dialmon works. If it
does not work, try to install tcl8.3 too.
I hope your wish comes through.
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Q Hi Mango, I subscribe to a daily 
e-mail that brings me a mixture of

.jpg and .tiff files. I like to store them in
my username/pix folder. I have many other
folders, but at the moment, when saving
from e-mail, the folder selection defaults
back to my username/greens folder. So,

for each picture I have to browse to the
pix folder. And with the next picture, it
goes back to my greens folder. This is
very annoying.

I would like to be a bit more “cluey”
about fixing problems myself, so I would
like guidance to a place where people

report bugs and they get fixed. Could you
point me to a simple-to-use Ubuntu place?
In any case, can you fix my problem?—
Denise Tzumli

A You do not tell me which e-mail pro-
gram you are using. Are you using

Mozilla Thunderbird? If you are using
Thunderbird, select Edit→Preferences from
the main menu. You will see a dialog like
the one shown in Figure 1. Click on the
Attachments icon.

Do you see where you can tell
Thunderbird to save all your attachments?

Are you using Evolution? I do not
think you can set a default save folder in
Evolution.

Are you using a Web-mail program?
You should look through the Firefox
extensions. Click Tools→Extensions and
click on Get More Extensions. You will
get a new Web page with Firefox
extensions. Some extensions let you
define a place to save pictures and
another place to save links.

I hope maybe some of this helps you.�

I am a sweet, humble, delicate and very cute genius
who is at your service to answer your Linux questions.
Send your questions to mango@tuxmagazine.com. I
am deeply sorry that I do not have time to respond to
anyone directly by e-mail, but I will select as many
questions as I can and answer them here.
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Figure 1. Thunderbird Attachment Preferences
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If you use a computer, you almost certainly use e-mail. If you ever put any
financial, business or personal information in your e-mail messages that you
don’t want the whole world to see, stop sending those e-mail messages until
after you read this article.

When you send e-mail, it goes out of your computer, exactly as you typed
it, and can be read by anybody that’s on the route your e-mail takes to reach
its final destination. And, I don’t mean only the folks at your ISP/cable/phone
company. Your neighbors on the same cable run can see it, people whose
Web servers connect to your ISP’s network may be able to see it, and if
you’re the paranoid type, maybe Big Brother can see it too.

If you use Thunderbird as your e-mail client, the way to use your e-mail
with confidence once again is Enigmail. Enigmail is a Thunderbird extension
for encrypting e-mail. When you use Enigmail to encrypt your messages, only
the designated receiver of the e-mail can decrypt and read the e-mail; others
will see only gobbeldygook. If you are the paranoid type, you’ll be happy to
know that Enigmail also causes Thunderbird to save copies of your sent e-
mails in encrypted format. So, even if your computer is somehow compro-
mised, your messages will be safe from prying eyes. If you’ve never heard of
Enigmail before, perhaps you’ve heard of PGP, OpenPGP or GnuPG—for our
purposes, all of these can be considered synonymous with Enigmail.

So what’s the catch? Well, there is one, and it’s a big one: using Enigmail
is useful only if you have somebody else to play with. If the people to whom
you’re sending e-mail don’t have Enigmail or a compatible program installed,
you can’t send them encrypted mail, because they wouldn’t have any means
of decrypting it. This probably seems obvious once you think about it, but it’s
an easy point to overlook during your initial euphoria. I’m sure you paranoid
types are thinking I’ve forgotten the biggest catch of all: Big Brother can still
read your e-mail, right? Wrong. Or at least in my opinion, Big Brother is no
more likely than anybody else to able to decrypt your message.

HOW DOES IT WORK?
Enigmail uses a pair of keys, one for encrypting and one for decrypting.
These keys are referred to as the public key and the private key, and they are
a pair of keys; they work only with each other. You give the public key to
others so they can send you encrypted e-mail. You never give the private key
to anybody, and you use it to decrypt e-mail sent to you that was encrypted
with your public key. There’s an important point above that doesn’t always
register: you don’t use your public key to encrypt e-mail; you use the receiv-
er’s public key. So again, you need others to play with, and you need them
to want to play with you, because they have to give you their public key
before you can send them encrypted e-mail.

SO WHAT’S THE CATCH? WELL, THERE IS 
ONE, AND IT’S A BIG ONE: USING ENIGMAIL 
IS USEFUL ONLY IF YOU HAVE SOMEBODY 
ELSE TO PLAY WITH.

When you create your key pair, you will be asked for a passphrase for
unlocking your private key. This passphrase is very important. If your comput-
er is compromised, it prevents somebody from using your private key to
decrypt your e-mail. It’s also very important not to forget your passphrase—
much more important than not forgetting the root password to your com-
puter. If you forget the root password to your computer, there are ways of
recovering access to your computer, but if you forget the passphrase for your
private key, there is no way to recover it, and no way to decrypt your saved
e-mail. Obviously, a hard-to-guess password is important. All the encryption
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in the world doesn’t do any good if you use your
first name as the passphrase.

INSTALLING ENIGMAIL
At the time of this writing, the latest release of
Thunderbird is version 1.5.0.5. You can download
the latest release at http://www.mozilla.com/
thunderbird. The latest release of Enigmail is

0.94.1 (at the time of this writing). You can
download the latest release of Enigmail, as well as
other extensions, at https://addons.mozilla.org/
thunderbird. 

Generally, a new version of Thunderbird
requires a new version of Enigmail, so be care-
ful when upgrading to make sure Enigmail will
still work. Typically, new versions of Enigmail

become available very soon after, or simultaneously
with, new releases of Thunderbird. On occasion,
you can get Thunderbird to work with an old
version of Enigmail by re-installing the old version
of Enigmail.

Unlike Firefox extensions, you cannot click on 
a link in Thunderbird and install an extension. You
have to download the extension (a file ending in
.xpi) and then install it from the downloaded
copy. Currently, the exact URL to get to Enigmail 
is https://addons.mozilla.org/thunderbird/71. 
Look for the link that says Install Now for Linux
(Figure 1), but don’t click the link. Instead,
right-click on the link, and select the Save Link
As option to download a copy of the file. The
file that it asks you to save should be named
enigmail-0.94.1-tb-linux.xpi.

If you like working with the shell, you also can
fire up your favorite terminal, change directories
to where you want to save the file, and type:

wget http://releases.mozilla.org/pub/
�mozilla.org/extensions/
�enigmail/enigmail-0.94.1-tb-linux.xpi

(Although I’d suggest copying and pasting the
URL rather than typing it.)

Now that you have the extension, start
Thunderbird and select the menu option
Tools→Extensions. This opens the Thunderbird
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Figure 1. Click on this link to download Enigmail.

Figure 2. The new menu item appears in
Thunderbird after installing Enigmail.
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Extension window. Click the Install button in the bottom-left corner of the
window. This opens a file selector window titled Select an extension to

install, and use this to find the .xpi file that you saved above. When you find
it, click Open to install the extension. This opens another window that veri-
fies that you want to install the extension; click Install Now. When this com-
pletes, close the Extensions window, and then restart Thunderbird. When
Thunderbird restarts, you should now have a new option: OpenPGP on the
menu bar (Figure 2). You can now proceed to configure Enigmail.

CONFIGURING ENIGMAIL
From the menu, select OpenPGP→Key Management. This opens the the
OpenPGP Key Management window, and because this is our first time run-
ning Enigmail, the OpenPGP Setup Wizard should open. The Wizard presents
the following steps/windows:

� Welcome to the OpenPGP Setup Wizard: select Yes to use the wizard
(Figure 3).

� Signing: select No to create per-recipient rules for signing your e-mail
(Figure 4).

� Encryption: select No to create per-recipient rules for encrypting your e-
mail (Figure 5).

� Preferences: select No to use the defaults (Figure 6).

� Create Key: enter a passphrase for your key pair (Figure 7). Above the first
passphrase input box, you should see your name and e-mail address and
the Thunderbird E-Mail Account ID.

� Summary: shows you information about the key to be created; the next
step will actually create the key.

� Key Creation: wait for the new creation to complete (Figure 8). When it
completes, it will ask you if you want to save a revocation certificate for
your newly created key (Figure 9). If you choose to save one, you will be
prompted for your passphrase.

� Thank You: the Wizard has completed. Click Finish.
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Figure 3. Remember to select Yes to start the wizard.

Figure 4. Select No to create per-recipient rules for signing your e-mail.

Figure 5. Select No to create per-recipient rules for encrypting your e-mail.

Figure 6. Select No to use the default settings.
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SENDING A TEST E-MAIL
Enigmail should now be configured. The first test you should do is to try 
to send yourself an encrypted message. Click the Write button on the
Thunderbird toolbar to create a new e-mail. First, make sure that you are

going to send an encrypted e-mail by selecting OpenPGP on the menu and
ensure that Encrypt Message is checked/selected (Figure 10). In the To: input
box, enter your own e-mail address. Now, enter a subject, type something in
the body of the message, and send the message.

When the message arrives, select it in the message list. The first time you
select an encrypted message, Enigmail asks you for your passphrase.
Enigmail uses your passphrase to gain access to your private key, which it
then uses to decrypt the e-mail message. You may have noticed that the
subject line is readable even before you enter your passphrase. This is anoth-
er important thing to remember: only the body of the message gets encrypt-
ed; the subject line does not, so don’t put any important information in the
subject line. After entering your passphrase, you should be able to read the
body of the message, and you should see the OpenPGP line at the top of the
message display indicating that the message has been decrypted; there also
should be a key icon off to the side of the message display (Figure 11). If you
see garbage—something enclosed by the lines “-----BEGIN PGP MESSAGE-----”
and “-----END PGP MESSAGE-----”, something has gone awry. In this case,
try selecting the menu options OpenPGP→Clear Saved Passphrase and then
reselect the message; this will re-prompt you for your passphrase. If you
mistyped your passphrase, Enigmail can’t decrypt messages.

SENDING ENCRYPTED E-MAIL TO OTHERS
Now that you have Enigmail working, it’s time to take it out for a spin. To
send encrypted e-mail to people, the first thing you need is their public key.
Generally, there are two ways to obtain people’s keys: the first method to
have them send their public key to you, which you then import into Enigmail.
The second, and more likely, scenario is that they have uploaded their key to
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Figure 7. Enter a passphrase for your key pair.

Figure 8. Wait for the new creation to complete.

Figure 9. Generating the Key
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a public keyserver, and you can then import it from the keyserver.
If individuals send you their public key in the body of a message, while

viewing the message, select the menu options OpenPGP→Sender’s
Key→Import Public Key to import their key. The message will look much like
an unencrypted message, except the enclosing “----... PGP ...----” lines at the
top and bottom will be different. If the key arrives as an attachment to an e-
mail, select File→Attachments→0xHHHHHHHH.asc→Open to import the key
(the HHHHHHHH part will be different for each key). In both cases, you will
be prompted further to make sure you want to import the key.

If you want to get keys from a keyserver, select the menu option
OpenPGP→Key Management. This opens the OpenPGP Key Management

window, which we saw briefly before when we were running the Setup
Wizard. At this point, the window shows only your key (Figure 12). From the
menu of this window, select Keyserver→Search for Keys; this opens a search
window. Enter a search string in the Search for key box (Figure 13). You can
search for people’s names or e-mail addresses or part of their names or e-
mail addresses. So, you can search for everybody named Smith or everybody
with e-mail at smith.com. If something is found, you will see something like
that shown in Figure 14. Select the keys you want to import, and click Ok.
At this point, the OpenPGP Key Management window will contain your key
and any keys that you selected for import (Figure 15).

Now, close the OpenPGP Key Management window, and send an e-mail
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Figure 10. The Encrypt Message Menu

Figure 11. The Key Icon off to the Side of the Message Display—Used to
Decrypt a Message

Figure 12. The list of available keys—right now, only yours is available.
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to one of your newly found contacts. Again, remember to make sure that
Encrypt Message is checked/selected (Figure 10) before you send the e-mail.

After you become comfortable using Enigmail, you probably will want to
upload your public key to a keyserver so others can find your key and send
you encrypted e-mail. You can do this from the OpenPGP Key Management
window by selecting your key and then selecting the menu option
Keyserver→Upload Public Keys.

RECEIVING ENCRYPTED E-MAIL FROM OTHERS
Receiving encrypted e-mail is easy; you already did this when you sent an

encrypted e-mail to yourself. The hard part is helping your friends and associ-
ates get their encrypted e-mail working!

OTHER CONFIGURATION OPTIONS OF INTEREST
You also may want to explore some of the other Enigmail options/prefer-
ences by selecting the menu option OpenPGP→Preferences. Under Sending,
you may want to check Always confirm before sending. This causes Enigmail
to tell you whether it is going to send the e-mail encrypted and asks you
to confirm that decision before it sends. Under Key Selection, you may
want to check Prompt for every unknown recipient. This causes Enigmail
to ask you what to do when you send e-mail to somebody that you’ve
never sent e-mail to before.

There are also some OpenPGP-related options under Thunderbird’s
account settings. Select the menu options Edit→Account Settings, and then
click on OpenPGP Security in the list box on the left side of the window.
Here you may want to select Encrypt messages by default, so you don’t have
to worry about selecting Encrypt Message before sending.

It might be a stretch to say that setting up and using encrypted e-mail
is simple, but it has gotten a lot easier over the years. With a little perse-
verance, you can get it up and running and feel secure in the knowledge
that your e-mail messages will be readable only by the people to whom
you send them.�

Mitch Frazier has been working with computers since 1979 doing system programming, application
programming and system administration. He has worked with UNIX and friends on and off since
the early 1980s and exclusively with Linux since 2001. Over the years, Mitch has worked on
mini-computers, PCs and micro-controllers using numerous programming languages and tools.
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Figure 13. The Search for Key Box

Figure 14. The Screen to Import the Selected Key

Figure 15. The List of Available Keys, with the New One Added
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Imagine you accidentally deleted your legacy e-mail messages today. Feeling
a little...nervous? I sure would. My old e-mail messages form a journal of
activities for my business and personal lives. If I were one of those really
organized folks (I’m not), I would copy all the important stuff elsewhere.
Because most of us don’t capture all the right details in the proper place, our
e-mail baskets become a search bin for old information like e-mail addresses,
appointments and phone numbers.

Thus, pre-Linux users can become excited about switching operating sys-
tems, and then fall flat on their noses with e-mail migration problems.
However, a little easy preparation will enable you to take all your old
Microsoft Outlook e-mail data with you into KMail.

GET READY...
I hope you’re reading this article before proudly wiping the Windows parti-
tion from your hard drive! If not, let’s hope your last data backup included
the e-mail files from Outlook and Outlook Express.

If you use Microsoft Outlook, you need to get the data into Outlook
Express format for transfer into KMail. So, open Outlook Express, go to
File→Import Messages, and use the wizard to get all your e-mail into
Outlook Express (Figure 1). This converts the data to .dbx format.

Next, you need to find the .dbx files. With Outlook Express still open, use
your mouse to right-click on the Inbox in the files directory (Figure 2). Click
the Properties link, and make a note of the subdirectory. Then, go to the
subdirectory, and copy all the files ending in .dbx to your backup storage
medium. When complete, you should see several files, such as Inbox.dbx,
Sent.dbx and Deleted.dbx, in a directory on your chosen storage medium.

If Outlook Express was your e-mail program, simply find the files we just
mentioned and copy them to a good storage location.

GET SET...
E-mail migration is only a small part of an overall plan to switch to Linux. I’m

going to assume you already used a similar plan to copy the remaining por-
tion of your important data files in satisfactory manner.

If you use only one personal computer, you can now scrub the Windows
partition and load your choice of Linux onto your desktop. Normally, most
distributions include KMail with the base KDE desktop. KMail runs by itself if
you type kmail at a terminal prompt. Or, you can start Kontact and work
with KMail as part of the included toolset.

Now, it’s time to bring KMail up to date with all your e-mail files. Open

Migrating from Microsoft Outlook to KMail
Welcome to the new KMail world.
DONALD EMMACK

Figure 1. Importing Outlook Messages into Outlook Express
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KMail, as shown in Figure 3, and choose Import.
KMail opens an e-mail migration utility like the
one shown in Figure 4. Choose Import Outlook
Express Email and click Next. I saved my .dbx files
into a directory called outlookexpress and copied
it to my new Linux desktop for easy access. Locate
this file with the Import wizard and press Ok.
KMail hunts for the Outlook Express e-mail files
and imports them into KMail.

If you have e-mail files with thousands of e-
mail messages, it might be best to split the
Outlook Express folders into separate files before

conversion. For example, create a new folder
called Inbox2 and copy half of your Inbox data to
this folder. If KMail is unable to process them all
at one time, move Inbox2 out of the directory
KMail is working with until you’re done process-
ing Inbox. Then, direct KMail to the directory with
Inbox2 and repeat the same process. Figure 5
shows KMail completed the import successfully.

GO!
You’re done! Now you have all your old Outlook
Express or Outlook e-mail data into the superior

KMail application. As shown in Figure 6, KMail’s
import tool loads the new files into a folder called
OE-Import. In my example, KMail imported only
one folder from Outlook and Outlook Express
called Inbox. If you have data in more folders,
they will appear in the same location. This proce-
dure worked when I tested e-mail messages with
and without attachments.

Now, you can drag and drop the old e-mail
into your KMail folders or leave them in the pre-
made folder for archival reference.
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Figure 2. Right-click on Inbox and select
Properties.

Figure 3. Opening KMail

Figure 4. KMail’s Migration Utility
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EXTERNAL E-MAIL CONSIDERATIONS
I write for both TUX and Linux Journal and need to test Linux distributions all
the time. I change my desktop operating system so often it boarders on
madness. Although Linux makes it quite easy to transfer data, I don’t enjoy
shifting my e-mail between machines and programs enough to do it each
time I test a new desktop. Thus, I rely on external e-mail.

I tried several Web-based e-mail solutions, but I like Gmail best. As men-
tioned earlier, e-mail contains important data, and I like to keep it immedi-
ately available. Consequently, Gmail is my off-site storage for e-mail data.

If you don’t like Web-based e-mail, you can still use Gmail for storage.
Simply configure KMail to leave inbound messages on the Gmail server. For
messages you send through KMail, you can use the KMail redirect feature, as
shown in Figure 7. Redirect lets you send the message to another location,
like your Gmail address.

Although this works, it’s also a good way to foul e-mail message organi-
zation beyond your grasp. So, I decided to stay with Gmail as my primary e-
mail source. I know there are concerns about security, but in my line of work
I’m not overly concerned about the issue.

SUMMARY
I continue to see great possibilities in Linux for both business and personal
use. Chopping down desktop migration issues is critical to gaining greater
acceptance in the market. I say “well done” to the KMail migration team.�

Donald Emmack is Managing Partner of The IntelliGents & Co. He works
extensively as a writer and business consultant in North America. You
can reach him at donald@theintelligents.com or by cruising the 2 meter
amateur RF bands in the Midwest.
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Figure 5. Mission accomplished!

Figure 6. KMail’s Import Tool

Figure 7. KMail’s Redirect Feature
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Thunderbird is so straightforward in use that most users never touch its
more-advanced features. But, even if you don’t consider yourself a
Thunderbird power user, you might want to take a closer look at the tools it
has to offer. Chances are you can dramatically improve your e-mailing habits.

USING FILTERS
Filters allow you to sort incoming e-mail automatically into specified folders.
They are great time-savers that can help you keep your inbox nice and tidy
without lifting a finger. Let’s take a concrete example that shows how to
configure and use a simple filter. If you stumble upon an interesting Web
site, and you want to keep a copy of it, you can e-mail it to yourself. Many
Web sites provide an “e-mail this page” feature, or you can use the excellent
Toread service (http://toread.cc). This can come in quite handy not only if you
want to keep a copy of an interesting article, but also if you want to read
something later or when off-line. If you use this facility often, you can end
up with copies of Web pages scattered all over your inbox. A better solution
is to create a separate folder and define a filter that puts the incoming Web
page copies into it.

To create a new folder, right-click on your e-mail account in the Folders
pane and choose the New Folder menu item. Give the folder a name (for
example, Toread), and press OK. The first thing you have to do in order to
create an effective filter is figure out what e-mail message criteria to use.
Filters in Thunderbird offer a myriad of criteria allowing you to create rather
sophisticated sorting tools. In this case though, you can use just a single rule
based on the sender’s address (assuming for our example that you are using
the Toread service). Choose Tools→Message Filters, press the New button,
and type the name of the filter in the Filter Name field. From the first drop-
down list, select From, set the second drop-list to is, and type the appropri-
ate e-mail address (in this case, info@toread.cc) into the last field. In the

Perform these actions section, select Move Message from the first drop-
down list, and select the Toread folder from the second list. The finished fil-
ter should look like the one shown in Figure 1. Press OK to save the settings
and close the window, and make sure the filter is enabled (the Active check
box should be ticked). If you already have e-mail messages from the Toread
service in your inbox, you might want to run the filter right away by pressing
the Run Now button. This moves all the existing Toread messages to the
specified folder, and from now on, any incoming e-mail that matches the cri-

Thunderbird beyond the Basics
Keep your e-mail secret and encrypted, easily.
DMITRI POPOV

Figure 1. Creating a Simple Message Filter

http://toread.cc
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teria specified in the filter will be moved to the
Toread folder automatically.

Other handy tools also can help you keep tabs
on your inbox. Sometimes you’ll want to move
individual messages into different folders manual-
ly, and in this situation, filters are of no use. What
you need is the TB QuickMove extension
(http://www.extensionsmirror.nl/
index.php?showtopic=1330) that allows you to
move the currently selected messages into a speci-
fied folder using a user-defined shortcut. To install
the extension, download it to your computer. To
do this with Firefox, right-click on the download
link and select Save the link to disk. In
Thunderbird, choose Tools→Extensions, press the
Install button, and select the download .xpi file.
Restart Thunderbird, choose Tools→Extensions
once again, select the TB QuickMove extension,
and press the Preferences button. Use the Quick
Move Preferences dialog window to assign the
desired folder to a shortcut.

Another clever tool is built right in to
Thunderbird, and it’s called Smart Folders. This
nifty feature allows you to save your searches as a
virtual folder. Using Smart Folders, you can specify
a set of search criteria, then save the search and
view it as a conventional folder. For example,
instead of using a filter to move messages from
the Toread service into the specified folder, you
can create a smart folder. The main difference
between the two approaches is that the smart
folder is not a real folder and no messages are
actually moved into it. In other words, the smart
folder is just a virtual folder, and every time you
select it, it runs the specified search and displays
the results.

There are several ways to create a smart folder.
The fastest way is to type your search criteria into
the Quick Search field, then select Save Search as
a Folder from the drop-down list. Alternatively,
you can choose File→New→Saved Search and
define a new search. This option allows you to

create a saved search that includes subfolders and
runs across multiple accounts. No matter which
way you choose to create a smart folder, you
always can modify its search criteria by right-click-
ing on it and selecting the Folder Properties item.

USEFUL THUNDERBIRD EXTENSIONS
Besides TB QuickMove, many other extensions can
significantly improve your e-mailing tasks. There
are two extension repositories, which you can use
to browse and choose the extensions you want.
The first one is Mozilla’s official extensions Web
site (https://addons.mozilla.org/
extensions.php?app=thunderbird), and it should
be your first stop when you are shopping for
extensions. Another good place is Extension
Mirror (http://www.extensionsmirror.nl/
index.php?showforum=3). Which extensions you
choose to install depends on your specific needs,
but a couple tools are a must-have for every
Thunderbird power user.
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Figure 2. TB QuickMove allows you to move mes-
sages into folders using keyboard shortcuts.

Figure 3. Creating a Saved Search, AKA Smart
Folder

Figure 4. Xpunge is a must-have extension for
keeping Thunderbird running smoothly.

http://www.extensionsmirror.nl/index.php?showtopic=1330
https://addons.mozilla.org/extensions.php?app=thunderbird
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When you delete messages, Thunderbird doesn’t actually erase them, but
“hides” them. If you don’t compact the folders on a regular basis, you can
end up with swollen folders that can cause Thunderbird to behave erratically.
However, compacting folders manually, one by one, especially when you
have several e-mail accounts, can be a bit of a bother. Fortunately, the
Xpunge extension (http://www.cs.ualberta.ca/%7Etegos/mozilla/tb/
index.html) can compact folders for you and empty the trash for good meas-

ure. Install the Xpunge extension, right-click somewhere on Thunderbird’s
toolbar, and select Customize. Drag the Xpunge and MultiXpunge buttons
onto the toolbar and press Done. To configure Xpunge, choose
Tools→Xpunge→Preferences. Under the Xpunge tab, you can define what
actions Xpunge should perform for a currently selected account, and
MultiXpunge allows you to specify actions to be performed on several
accounts in one go. Under the Timer tab, you can set Xpunge to run auto-
matically, for example, on startup and every hour.

Quotecollapse (http://quotecollapse.mozdev.org) is another nifty extension
that collapses quotes in the message body. This may not sound like much,
but it makes it easier to read messages and add in-line replies. Install
Quotecollapse, restart Thunderbird, and you will see that the quotes in every
message are now collapsed. To expand a quote, click on the tiny Plus icon
next to the quote.

Gmail is one of the most popular e-mail services out there, and if you
fancy its features, you can use the GMailUI extension
(http://www.longshot.com/~kmixter/gmailui.html) to add some of Gmail’s
functions to Thunderbird. These functions are mostly related to search, and
they can come in handy if you often need to search through thousands of e-
mail messages. For example, you can use the Quick Search field in
Thunderbird to run Gmail-like search queries, such as from:toread, to:martin,
subject:rare monkey and so forth. You also can write complex queries that
contain several criteria. GMailUI allows you to perform searches on smart
folders as well. You even can use the search field to perform simple calcula-
tions. For example, type 7+321*52, press the Enter key, and you will see the
result: 7 + (321 * 52) = 16699.

FINAL WORD
As you can see, becoming a Thunderbird power user is not that difficult. All
you need are a couple extensions and a day or two to master Thunderbird’s
advanced features. Once you’ve done that, you can deservedly call yourself
an e-mail guru.�

Dmitri Popov is a freelance writer whose articles have appeared in Russian,
British and Danish computer magazines. His articles cover open-source
software, Linux, Web applications and other computer-related topics.
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Figure 5. GMailUI adds some useful functions to Thunderbird, including the
Archive feature.
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There’s a difference between hardened informa-
tion technology (IT) folks and personal computer
enthusiasts. IT people like the system to work and
keep an orderly static appearance. On the other
hand, typical personal computer users overhaul
the look of their screens just for fun. Thus,
SuperKaramba appeals to many personal comput-
er users by offering ways to liven up desktop
appearance.

However, SuperKaramba is more than a simple
eye-candy widget. It also supports useful themes
providing real-time information bundled with pret-
ty graphics. In this article, we probe two ways to
receive weather data for your computer.

WHERE TO FIND SUPERKARAMBA
You can find SuperKaramba in the Adept package
manager for Kubuntu. Simply install the applica-
tion and start it through your Start menu or termi-
nal. Themes for SuperKaramba install through the
program itself, so you don’t need Adept for any-
thing further.

OUT OF THE BOX
SuperKaramba offers various themes for you to
install. Some are purely for making the KDE desk-
top look spiffy. No doubt, your Windows-using
friends will envy the way your PC looks after you
install some of the themes. However, you also can

capture attention when you use real-time themes
that gather XML data from the Internet.

LOOKING FOR LIQUID WEATHER?
Liquid Weather is a neat application to keep an
eye on the weather forecast. Start SuperKaramba,
and you will see the home screen of the applica-
tion, as shown in Figure 1. Now, press the Get
New Stuff button, and SuperKaramba searches
the Web for various themes you can install. In my
example, more than 100 themes are available, as
shown in Figure 2.

Notice in Figure 2 I’ve selected Liquid Weather.
Select Install (Figure 3), and SuperKaramba opens
the main Internet page for Liquid Weather, as
shown in Figure 4. Usually, SuperKaramba loads
the application immediately. For Liquid Weather,
you first need to download the theme file onto
your computer. Go to the Downloads section, and
save lwp-13.1.1.skz (or the most recent release)
onto your hard drive.

Next, go to SuperKaramba’s home screen and
choose Open Local Theme, as shown in Figure 5.
Find the .skz file you downloaded, select it and
press Open. Momentarily, SuperKaramba will load
Liquid Weather and start it on your desktop
(Figure 6).

As expected, SuperKaramba doesn’t know
where you live, so you’ll need to set the proper

location to get weather data for your area. Right-
click on the desktop theme and use the easy
setup tools to tell SuperKaramba where you are.

SuperKaramba
Theme your desktop with real-time information.
DONALD EMMACK

Figure 1. Home Screen for SuperKaramba
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You can use either data from Weather.com or
Accuweather. Apply your changes and you’re
done!

FOR SERIOUS WEATHER JUNKIES
I live in an area where we have extreme weather
changes. Specifically, I live in the middle of
Tornado Alley in the USA. So, for about two

months of the year, I’m really interested in devel-
oping weather patterns. I’m also a Ham radio
operator and listen to reports from weather spot-
ters. Thus, knowing the five-day forecast is nice,
but impending tornado warnings are much more
interesting.

Fortunately, WeatherWatch is available as a
theme for SuperKaramba. WeatherWatch allows

SuperKaramba to gather real-time XML data from
the National Oceanic & Atmospheric Association
(NOAA). NOAA is the approved agency in the USA
to issue weather warnings.

You’ll find WeatherWatch at http://www.kde-look.org/
content/show.php?content=16396. Download and
unzip the file into a memorable spot on your
hard drive. Then, use SuperKaramba to open
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Figure 2. SuperKaramba has more than 100 themes included.

Figure 3. Use the Install button to start the down-
load.

Figure 4. The Main Page for Liquid Weather on the
Internetload.

http://www.kde-look.org/content/show.php?content=16396
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the theme and start it on your desktop. Start
WeatherWatch by using Open Local Theme and
find the file named NOAA.theme on your hard
drive. Open this file to start the applet. Now
you should see all the advisories issued by
NOAA (Figure 7).

NOAA can be so busy that you won’t want to
wade through the data to find your local informa-
tion. But, it’s easy to change the code to find your
local weather warnings. To do this, we use the
XML data provided by NOAA. To get the right one,

go to http://www.nhc.noaa.gov/aboutrss.shtml and
look for XML feeds interesting to you. Or, you also
can go to http://www.weather.gov/alerts and look
for experimental feeds by location.

Now, open the directory where you down-
loaded WeatherWatch and find the file named

NOAA.py. In the first part of the file, we will
change the feedURL to a location found in your
search of the NOAA Web site. Open NOAA.py
with the Kate text editor, and look for the line
starting with feedURL, as shown in Figure 8.

Figure 9 shows how I’ve changed the feedURL
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Figure 5. Use the local theme feature to run
downloaded themes.

Figure 6. Looks cool—right?

Figure 7. The NOAA Warnings Listing
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to match the XML data for my area in Missouri. Paste your chosen XML code
between the quotes, then save and exit the file. Finally, exit and restart
SuperKaramba, and then restart the WeatherWatch theme. Now you can
watch for developing weather alerts.

THE TAKE AWAY
SuperKaramba is much more than a cool toy for Linux desktop users. There are
several theme features that give you useful information wrapped up in a pretty
picture. There are also some amazing graphics SuperKaramba can display. I 
recommend you use it to intensify jealous feelings in Microsoft Windows users.�

Donald Emmack is Managing Partner of The IntelliGents & Co. He works
extensively as a writer and business consultant in North America. You
can reach him at donald@theintelligents.com or by cruising the 2 meter
amateur RF bands in the Midwest.
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Figure 8. Changing the feedURL Location to Your Area

Figure 9. “All Clear” for the Missouri Weather Area

Figure 10. If a weather alert does occur, mouse over the alert link, and the
full text of the event is displayed on your screen.
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Although I discuss burning a CD here, the same
process applies to burning a DVD. The type of
download we are talking about is a CD image,
which is commonly called an ISO image. This,
of course, differs from downloading a music,
data or video file.

DOWNLOADING
If you ever have downloaded something on any
system, there is no magic here. The most common
thing you do is find a download page using your

Web browser and click on the
correct download link. In some
cases, doing a right-click and
save is the right answer.

But, that is not the only way.
Let’s say someone told you the lat-
est Dapper Drake ISO CD image
was at http://ubuntu.cs.utah.edu/
releases/kubuntu/6.06/
6.06.1-desktop-i386.iso
(which it was as I wrote this).
You simply could feed this
URL to KGet. If KGet is

already running, you should see a blue down-
pointing arrow (Figure 1) in your panel. Click
on it. Otherwise, you can start KGet from the
run box (press Alt-F2) and enter kget.

Downloading and Burning an ISO CD
You probably didn’t get your first Linux CD by burning it on a Linux system, but that is certainly how you should get your next one.
PHIL HUGHES

Figure 1. KGet
Arrow on the
Panel

Figure 2. KGet

Figure 3. Open Transfer Box

http://ubuntu.cs.utah.edu/releases/kubuntu/6.06/6.06.1-desktop-i386.iso
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When KGet starts, you will see a window like
the one shown in Figure 2. Click Open in the File
menu, and enter the URL into the Open Transfer
box, as shown in Figure 3. Click on OK, and then
select where you want KGet to save the file.
That’s it. The transfer starts, and KGet shows you

the statistics on how much data has been trans-
ferred and provides a guesstimate as to the time
remaining.

Right-clicking on a transfer gives you some
options, such as the ability to pause and resume.
Be careful, because Resume means start from

where you were, but Restart means start over
from the beginning.

BURNING
Once you have the image, you need to burn the
CD or DVD. Put your blank media into your CD or
DVD burner, and wait a bit. Depending on how
your system is configured, K3b may start automat-
ically or a blank CD-R icon will appear. Worst case
scenario—if nothing happens, start K3b from the
Multimedia section of the K menu. When it comes
up, the display should look something like Figure
4. With the current version of K3b, you have but-
tons for Burn CD Image and Burn DVD ISO Image.
In older versions of K3b, you need to go to the
Tools menu to find this option.

RIGHT-CLICKING ON A 
TRANSFER GIVES YOU SOME
OPTIONS, SUCH AS THE 
ABILITY TO PAUSE AND RESUME.

Click the right button and select the image you
want to burn. In the Burn Image menu, one
option you might want to check is Verify written
data. This simply tells K3b that after it burns the
CD, it should read it back and make sure it is
identical to the file on your disk. If all looks fine,
click Start and go have a cup of coffee. Figure 5
shows what the display looks like as the CD is
being created. Note that I picked Simulating mode
as I don’t need another Dapper CD here.

Now, to the most neglected step: labeling your
new CD—don’t just write Linux on it. That
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Figure 4. Starting K3b
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reminds me of a guy I worked with long ago who
would always write the program name followed
by “latest version” on his program listings and put
the newest one on top of the pile in his bookcase.
I always wanted to switch the order just to see if
he would go crazy.

BOOTING
No magic here—simply put in the CD and restart
your computer. The only thing that could go
wrong is that your BIOS might not be set to boot
from the CD before the hard disk. That, of course,
is not a Linux problem, so you are on your own.

If you are booting the Dapper Drake LTS CD or
DVD, it boots up as a live system. That is, Linux
will be running off the CD drive. You can play
with it and make sure all seems to work well
before telling it to install on the hard disk.

If you have any extra Dapper CDs or DVDs,
they make great decorations for friends, cowork-
ers and family members. That is, just put them in
the CD drive on someone else’s computer. The
next time they turn it on and end up running
Linux, they will be very surprised—and no damage
will be done.�

Phil Hughes is Group Publisher for SSC
Media Corp.
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Figure 5. Creating the CD
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RSS readers grow more popular each day. Most of us like spending some
time studying the Internet for our daily dose of information. Yet easy access
to information becomes a slippery slope, consuming time and efficiency.

Internet browsers enable reckless Web exploring and can be addictive
time killers. Ten years ago, this was hardly a concern. Everyone read newspa-
pers conveniently organized into sections of interest. So, paper kept the
allure of information surfing minimized.

TODAY, USING THE FIREFOX BROWSER TO
INJECT YOUR BRAIN WITH A DAILY DOSE OF
NEWS IS OFTEN FATAL TO PRODUCTIVITY.

Today, using the Firefox browser to inject your brain with a daily dose of
news is often fatal to productivity. You read a story with two embedded links
and unwittingly find you have visited five more stories before you’re aware
of the time!

RSS TO THE RESCUE
What is RSS? RSS is an acronym for really simple syndication. In short,
it’s an effortless way to grab information off the Internet so you can
read what you’re looking for. I call this the “what you see is what you
need” (WYSIWYN) way to get the news.

RSS use is growing, and most of the Web sites I’m interested in support
it. To find out whether a site is RSS-enabled, look for a small RSS symbol on
the page. For example, on TUX magazine’s Web site, you will notice a small
RSS symbol. The symbol makes it easy to identify RSS capability. However,
some sites are RSS-enabled but don’t display the logo. Later, I’ll explain how
to read the news feed anyway.

In KDE, you can use several
RSS readers to obtain informa-
tion. Most distributions include
Akregator in their repositories,
so you can use the Adept
package manager for easy
installation.

On start-up, Akregator’s
home screen looks similar to
the one depicted in Figure 2.
The screen layout is similar to
an e-mail program. The list of
individual feeds is on the left,
and the stories for each feed
are on the top right. The
screen below displays the detail
of the selected story with any
graphics and links.

Akregator has a neat feature to tell you how many topics are unread in the
news reader. Figure 3 shows Akregator’s panel icon telling me 21 new arti-
cles are ready to read. After starting Akregator, you keep the notification in
the panel by closing the window. If you go to File→Quit, the program notifi-
cation icon will also close.

TO FIND OUT WHETHER A SITE IS RSS-

ENABLED, LOOK FOR A SMALL RSS SYMBOL

ON THE PAGE.

Akregator
Use Akregator to avoid reckless Web surfing.
DONALD EMMACK

Figure 1. TUX RSS Information
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ADDING NEWS FEEDS
After installing
Akregator, you need to
configure the program
to capture the right
news and information.
As an example, I will

show you how to add TUX magazine’s RSS feed.
First, go to Feed→Add Feed. Figure 4 

shows the Add Feed window. Next, type in
http://www.tuxmagazine.com/, and click OK.
Akregator searches for the RSS feed and opens
the Properties window, where you can tailor how
often to update the feed (Figure 5). Click OK

again, and you’re done!
Finally, click on the TUX link in the Feed win-

dow, and you will get up-to-date information
from the TUX Web site (Figure 6).

WORKING AKREGATOR
Now it’s time to put Akregator to work. Select the
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Figure 3. Akregator’s
Panel Icon

Figure 4. Add Feed Window

Figure 5. Properties WindowFigure 2. Akregator’s Home Screen
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TUX feed as before, and notice that you can use
the arrow keys to scroll through the list of infor-
mation captured from the Web site. The bottom
detail window shows a snapshot of the informa-
tion, with some graphics if available.

Consider Dmitri Popov’s recent article,
shown in Figure 7. You’ll see a link in the first
paragraph referring to the Kexi Project home
page. If you want to read more about Kexi,
click the link, and a new Akregator tab opens

showing the Web site (Figure 8). If you want to
browse the location with Firefox, use the right-
mouse button to click on the Kexi link and
“Open in External Browser”.

SETTINGS
It’s easy to tailor how Akregator works. Go to
Settings→Configure Akregator. Likely the only
item you will want to change is how often the
program updates feeds. Akregator defaults to
every 30 minutes; you might want this to be

more or less often (Figure 9). While you have
this window open, click through the different
settings to familiarize yourself with the
options. Click Apply and OK to save any
changes you make.

START THE PRESS!
I’m an easy touch for procrastination, so
Internet browsing mysteriously kills my time.
Using Akregator can expand your working
hours when all you want is to keep up to date
with certain information.�

Donald Emmack is Managing Partner of
The IntelliGents & Co. He works extensively
as a writer and business consultant 
in North America. You can reach him
at donald@theintelligents.com or by
cruising the 2 meter amateur RF bands
in the Midwest.
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Figure 7. Dmitri Popov’s Recent Article

Figure 8. Akregator Going to the Kexi Home PageFigure 6. Akregator Showing TUX Update

Figure 9. Configure Akregator

AKREGATOR HAS A NEAT 
FEATURE TO TELL YOU HOW
MANY TOPICS ARE UNREAD 
IN THE NEWS READER.

mailto:donald@theintelligents.com
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Every once in a while, you come across a program that is a true innovation in
the Internet community—Opera 9 is one such program. It wasn’t long ago
that there were only three major browser competitors: Internet Explorer,
Netscape and that “third” browser known as Opera. Curiously, Opera never
caught hold as a serious alternative and has never been able to reach
beyond a 2% market share. Firefox didn’t help matters any with its near
overnight success as an open-source substitute for the Internet Explorer
behemoth. Firefox now holds approximately 20% of the market on both
Windows and Linux systems, and word of mouth quickly spread the news
that launched this browser’s success. Not so with Opera. Opera is a
Norwegian invention, and it is a full-featured, charming Internet suite
with a reputation for its small size and lightning-fast speed. Opera was
the first to introduce tabbed browsing, and with Opera 9, released in June
2006, it continues to be a pioneer with several new features unavailable
on any other browser. It is the intent of this article to draw awareness to
this often overlooked browser and to reveal its innovative features in
some detail while explaining how to make your Opera browsing a safe
and enjoyable experience.

Opera is closed source, unlike Firefox, and it used to contain advertise-
ments for which users had to pay a small licensing fee to have removed.
There is no longer such a fee attached, and Opera 9 can be downloaded free
of charge with no ads. The Opera company makes no money off the brows-
er itself, but it does make money on paid support contracts and in Opera
downloads for smartphones and the like. So, even though Opera 9 is not
open source, it remains a serious competitor to Firefox and Konqueror, and
we feel that it ranks right up there in functionality and security. In fact, 
securia.com has stated that the Opera browser is the most secure browser
available with the fewest security breaches discovered—those that have been
found were fixed so quickly that there are none remaining. Take this as you
will—many nay-sayers might argue that the Opera browser has had the

fewest breaches because the Opera market share is so low, but isn’t this the
same argument that has been used against Linux? Even if this were true, the
simple fact is that Opera (right now) is considered the most secure browser
on the market—no one is denying that fact. So why isn’t Opera taking hold?

Marketing. No one wanted to pay for a browser when perfectly good
ones could be downloaded free of charge, and most users simply chose to
utilize the browser that came packed with their new PCs—Internet Explorer.
In the Linux community, Opera has not taken hold because it is not open

Opera 9 for Linux
It’s your Web; it’s your choice.
JAY KRUIZENGA

Figure 1. The Opera 9 browser—it’s all about choice.
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source and Firefox is. So it may be pure prejudice
over anything closed source that keeps Opera at
the fringe while Firefox continues to enjoy the full
support of the Open Source community. Still, it is
nice to know that other choices are available for
Linux, and closed source applications are going to
be an ever-present reality as Linux becomes a
stronger desktop competitor. This article is about
choice, and choice is the driving force of Linux.

HOW/WHERE TO DOWNLOAD OPERA 9
Opera 9 is available from http://www.opera.com
for every Linux distribution under the sun. Simply
choose your distro and download to your PC.
Install as you would any file on your system. You
can import your bookmarks from a previously

used browser by selecting File→Import.

HOW TO OPTIMIZE OPERA 9 FOR SECURITY
Although Opera is ultra-secure, supporting SSL
versions 2 and 3 plus TLS, in addition to support-
ing 256-bit encryption (banks rely on 128-bit)—
the highest security available for any Web brows-
er—you can take additional steps to make Opera
9 even more secure. With integrated antiphishing
technology (ID theft) and automatic checks for
security updates, you can rest assured that your
browsing experience will be a safe venture.

For additional security, it is possible to config-
ure Opera 9 to clear both cookies and cache
when exiting to protect your privacy. To do so,
you must tell Opera your preferences by clicking
Tools→Preferences→Advanced tab. Select cookies
from the menu, and make certain delete new
cookies when exiting Opera is checked. Now,
select History from the menu, and check the box
under Disk Cache that reads empty on exit.

There is an additional method of deleting his-
tory, cookies and cache upon exit (or at any time
you choose) found under the Tools menu: delete
private data. One click and mission accomplished.

HOW TO BLOCK ANNOYING POP-UPS WITH
OPERA 9
Firefox is famous for avoiding annoying pop-up
ads. Opera also blocks pop-up ads by default;
however, this default setting can be changed
according to your choice, either universally or by
Web site visited (those you trust). Press F12, and
your quick preferences window will open. There
you can choose to block all pop-ups, unwanted
pop-ups or to allow all pop-ups.

In order to accept pop-ups from a site you
trust, click your right-mouse button while in the
site and left-click Edit site preferences. The
changes made here will apply only to the site you
are visiting. On the General tab, you will find the
place to allow pop-ups.

Another method of viewing blocked pop-ups is
in the top-right corner of Opera where you will
see a trash can. Clicking on the can lets you see
all blocked pop-ups from your current browsing
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Figure 2. Press F12 for pop-up control.

Figure 3. Search the trash for blocked pop-ups.

Figure 4. Opera 9 with Cascading Windows
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session. You can choose any of those and open
them up in their own respective tab. You also can
empty the trash (by default these are deleted
when you exit Opera).

HOW TO CUSTOMIZE THE LOOK AND FEEL OF
OPERA 9
Like Firefox, you can customize the look and feel
of Opera. There are many skins available for
Opera, which can be found by pressing Shift-F12.
In the window that opens, you can find/download

more skins (no need to restart Opera, you can
change skins on the fly), enable special effects
and change the overall color scheme of your
selected skin. You really can get creative here.

You also can drag and drop buttons, search
fields and toolbars from this same menu. We
found a couple useful tools under Buttons→
Preferences. Drag and drop the Identify As menu
and the Pop-up Ads menu to the area of your
choice. With these you have quick access when
encountering troubled sites that require IE or
Netscape. Remember, most everything is cus-
tomizable through Opera 9.

WHAT TO DO IF YOU ENCOUNTER A PAGE OPERA
WILL NOT OPEN
Many pages on the Net are designed exclusively
with IE users in mind, and those Web sites will
blatantly tell you so. If you encounter such a
page, don’t panic—there is a little trick in Opera
that will get you by. Right-click on the troubled
site and select Edit site preferences. This brings
you into a menu where you must click the
Network tab, and there you can change your
browser identification for that site to “identify as
IE”. Or, if you added the Identify As menu to
Opera, click and reload. We encountered a few
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Figure 5. Opera 9 allows tiled browsing.

Figure 6. Opera broadcasts you are using Opera by
default.
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such sites in our testing of this browser, and
changing this setting did the trick each and every
time. Once the setting is changed, you will need
to reload the page.

HOW TO SET UP OPERA 9’S INTEGRATED E-MAIL
Opera includes an integrated e-mail client that is
equally as secure as the browser. You will need
to set up an e-mail account before use. Under
the Tool menu, choose mail and chat accounts,
then add. Enter your POP/SMTP details, and
you will be up and running. Editing an account
provides the options of customizing your signa-
ture and choosing when Opera should check
for mail.

When new mail arrives, the taskbar icon
changes in appearance to an Opera logo with 
a letter. In addition, a menu pops up to alert
you that new mail has arrived. To read incom-
ing mail, press F4, and then select the Mail
button. You will see all of your received mail
plus all the messages you have previously read.
Opera has a teachable spam identifier and a
single click of the spam icon allows you to
change a message received to spam. By
default, all external images/JavaScript are
blocked. To change this, you must change the
setting under View→Display, unchecking block
external elements.
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Figure 7. F12→Edit Site Preferences allows you to
change the browser declaration to Internet
Explorer.

Figure 8. Opera 9 contains a full e-mail client.

Figure 9. The Opera icon in the taskbar alerts you
that you have new mail.

Figure 10. Press F4 to open the Mail menu.
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LIKE BROWSING WITH YOUR MOUSE? OPERA 9
SUPPORTS MOUSE SHORTCUTS
There are many helpful mouse gestures that can
assist in your browsing, if you feel so inclined. We
have listed a few of the main ones below for your
reference. Note: most of these gestures involve
clicking and holding down the right-mouse button
while moving the mouse in a certain direction.

First, you need to enable mouse gestures
from the Opera Tools menu under Preferences.
Within the opened window, select Advanced
tab→Shortcuts, and check the box that says
enable mouse gestures. Click OK and close 
the window.

Here are some of the gestures:

� Open a new document: right-click/hold and
move down.

� Close a document: right-click/hold and move
down then right.

� Go to a previous page in history: right-
click/hold and move mouse left or hold right
button and click left button.

� Go to the next page in history: right-click/hold
and move mouse right or hold left button and
click right button.

� Go to the home page: double-click inside an
empty window.

� Scroll up and down: roll the wheel back 
and forth.

� Zoom in and out: hold the Ctrl key and roll
the wheel.

� If you encounter a link that you want to open:
point the mouse to the link, then right-
click/hold and move mouse down.

The first couple of times these gestures may
feel a bit awkward; however, with a little practice,
you will discover how simple using a mouse to
browse the Net can be.

Opera 9 also has numerous (too many to
list) keyboard shortcuts that can be found by
visiting http://www.opera.com/products/desktop/
keyboard. For example, toggle the F11 key for
full-screen presentation modes—great when
making presentations!

SEARCH YOUR FAVORITE SEARCH ENGINE
QUICKLY WITH OPERA 9
Opera 9 includes several preloaded search options.
For instance, if you want to search using Google,
in the address field simply enter the letter g fol-
lowed by what it is you want to search for. Opera
9 comes preloaded with several of these letter
searches: a for Answers.com, e for eBay and z for
Amazon.com, plus many more. You can find the
whole listing under Tools→Preferences→Search.
You may discover that your favorite search engine
is not listed, but that’s easy to fix. Browse to the
search engine of your choice, right-click on the
search field and select create search. A window
appears enabling you to name your new search
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Figure 11. Add your favorite search engine with a simple click.
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engine and choose an appropriate keyword that
you will enter into the address field to conduct
searches. For instance, clicking on the search field
at dogpile.com brings up a new window where I
can enter Dogpile as the name and dog as my key-
word. Now whenever I wish to conduct a search
using Dogpile, I enter dog in the address field fol-
lowed by my search terms.

OPERA 9 NOW INCLUDES THUMBNAIL PREVIEWS
What if you have several tabbed windows open
and you need to find one in particular to go back
to, but are uncertain which tab it is? Opera 9 has
thumbnail previews, so all you need do is hover
your mouse over a tab and a small thumbnail pic-
ture appears that lets you see what is on that tab.
Another way to do this is to click the tile icon,
which places all open windows in their own space
within the Opera browser, making every window
partially visible.

REMEMBER IMPORTANT PASSWORDS WITH OPERA 9’S
PASSWORD WAND
Hate passwords? Opera 9 includes a Password

Manager that will make remembering passwords
easy. Each time you enter a new user name and
password, the Password Manager asks if you want
it to remember this information. If you choose this
option, the next time you visit that site, you can
either press Ctrl-Enter or click the wand icon found
adjacent the address field. It can’t get much easier
than that.

HOW OPERA 9 HANDLES SECURE SITES
How do you know for certain that the site you are
visiting is 100% secure? Besides looking for that s
in https, you also can look for the Opera padlock
on which you will find a number. That number is a
sure indicator of the level of security present at that
site. Click the padlock for additional information.

NEED A DIFFERENT LANGUAGE? OPERA 9 SUPPORTS
SEVERAL
You will find a multitude of supported languages
under the Tools→Preferences→General tab—
Arabic, Navaho, Tagalog, Chinese (several dialects),
Dutch and many more. Chances are your native
tongue will be found here.
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Figure 12. Enjoy tabbed browsing with thumbnail previews.

Figure 13. Opera 9’s Password Manager securely
remembers user IDs and passwords.

Figure 14. Click the wand icon to enter saved
passwords.

Figure 15. Click the padlock for security info.
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DESIGN PAGES WITH OPERA 9 AND REST
ASSURED THEY WILL LOOK THE SAME UNDER
ANY BROWSER
Web designers always have had a difficult time
getting code to render properly under various
browsers. Opera 9 takes great pride in the fact
that it is 100% in support of the major Web stan-
dards presently being used: CSS 2.1, XHTML 1.1,
HTML 4.01, WML 2.0, ECMAScript, DOM 2 and
SVG 1.1 basic. Opera 9 is the second browser to
pass the Web standard Acid2 test
(http://www.webstandards.org/action/acid2). Note:
Firefox comes close, but no cigar here. Internet
Explorer, needless to say, is way off. So, pages
designed using Opera 9 will render properly.

DOUBLE-CLICKING WORDS IN OPERA 9
If you double-click on a particular word you are
curious about within a Web page, a window

appears that lets you look up the word in a dic-
tionary, search an encyclopedia or conduct a
search with your favorite search engine. You also
can translate words on the fly.

640 WIDGETS...AND COUNTING
Finally, saving the best new feature added to
Opera 9 for last—widgets. Widgets are small
JavaScript/HTML/CSS programs that make your
Opera 9 browsing experience an enjoyable adven-
ture. There are more than 640 user-created widg-
ets on the Opera site for your review/download—
everything from multimedia (music player with
Pandora), newsfeeds, games (try Circular Tetris),
Webcams and much more. Pictured in Figures
18–21 are a free dictionary, chess, calculator,
Wikipedia search, digital clock, unit convertor,
aquarium game, Buddhist thought of the day,
touch the sky local weather from Accuweather,
browser security monitor, Slashdot news, count-

down to the TV premiere of Lost, the Pandora
music player (which customizes streaming audio
to your personal liking), the artist’s sketchbook
(simple drawing program), circular Tetris, Torrent
search, eBay search, HTML/CSS WYSIWYG editor,
Knowledgemate search and Seaworld San Diego
Shamu Cam (captured Shamu).

HATE PASSWORDS? OPERA 9
INCLUDES A PASSWORD
MANAGER THAT WILL MAKE
REMEMBERING PASSWORDS
EASY. 

Widgets are open only if Opera is open and
appear as separate programs on your Linux desk-
top. They can be made to appear atop every win-
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Figure 16. Opera 9 passes the Web standard
Acid2 Test—one of only two browsers to do so.

Figure 17. Double-clicking on a word gives you
search options.

Figure 18. Shamu Cam up Close—One of Many
Widgets
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dow by right-clicking the widget and choosing
always on top. Note: performance of widgets
involves having JavaScript enabled in your quick
preferences (F12).

To add widgets to Opera, press F4, select
Widgets and then Add. You will be taken to the

Opera Widget repository where you can browse
through all 640 widgets at your leisure. When you
find one you like, simply download and the widget
will open (no need to restart Opera). You will be
given the option of saving this widget or deleting if
you find you don’t like it.

Not every widget downloaded needs to be
open—it is your choice. Those you select to be open
will reopen when you restart Opera. This is con-
trolled with the F4 widget menu.

CREATING YOUR OWN WIDGET
From the menu bar, click Widgets→Add Widgets.
This opens Opera to the Opera Widgets page on
which you will see “make a widget in seconds with
Opera widgetize”. Follow this link. Click the large
green button that reads Create a Widget. On the
next page, the default style should be selected as
Feed Reader - Advanced. Click “I want this type!”
Enter the following title: Tux Magazine. Now, enter
the following URL in the space provided:
http://www.tuxmagazine.com/node/feed. Select a
skin—the second one in the top row looks sharp.
Finally, click “Make my Widget!” This leads you to a
page where you will find the code to be added to a
Web site or you can click “Try this Widget!” to
download instantly for your own use (which is what
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Figure 19. An Assortment of Available Widgets

Figure 20. Even More Widgets
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you would want to do with this particular creation).
Remember, to manage your downloaded widg-

ets: press F4 then Widgets→Add/Open.

OPERA 9—SO MUCH MORE THAN SPACE ALLOWS
So much more could be written concerning Opera
9, but sadly, we are limited on space. Other fea-
tures, such as integrated BitTorrent searches, internal
IRC chat, content blocking and transfer manager,

should be explored by you—the user. We covered
the newest features we thought would be most
beneficial to bring your attention to Opera, and in
such coverage, something is always missed. We
hope this article helps get you started with the new
Opera 9 browser with relative ease. We also hope
you agree that Opera 9 is an outstanding browser.
Although it’s not open source, it does offer choice.
And, isn’t that what Linux is all about? So, if this

article has produced even a minimal amount of
intrigue and/or interest, download Opera 9 and
decide for yourself!�

Jay Kruizenga, a former Marine, is 
an accomplished Marketer (specialty:
E-Commerce), business owner and
aspiring author. He has a deep love
for everything pertaining to Linux.
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Figure 22. Opera Download Page: http://www.opera.com/download

Figure 20. Even More Widgets

Figure 21. TUX RSS Feed Widget
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Acer has recently revamped its budget notebook line with larger screens
and built-in wireless, while dropping the price further still. This makes
the Aspire 3620 in particular a very attractive package. For $699 US
(http://www.amazon.com), the Aspire 3620 comes with a Celeron M 370 
at 1.5GHz, 256MB DDR2 memory, a 40GB disk and a CD-RW/DVD-ROM
combo drive. The Intel integrated graphics take up to a 128MB slice of
the system memory, making the addition of another memory module a
must. Connectivity is provided by a Realtek 10/100 Ethernet card, a 56K
Winmodem (untested) and a 54Mbps 802.11g Broadcom wireless card.
A 14.1" 1280x800 widescreen display rounds out the package nicely.

The machine is finished in an attractive matte silver with black plastic
inserts. The casing feels reasonably rugged, although the silver finish would
probably scratch easily. This is by no means an ultraportable, but at only
2.35kg, it’s no brick either. The only disappointment here is a measly 2.5-
hour battery from the 6 cell Li-Ion.

We tested this machine with Kubuntu Dapper to see how well it support-
ed Linux, and we were very pleased with the results. This machine has a
completely ACPI-compliant BIOS, which is quite rare. Suspend-to-ram works
flawlessly under Kubuntu, and the machine stays quite cool to the touch
even while under heavy load.

Sound, widescreen resolution and some multimedia keys (volume and
mute) worked out of the box. The sound card is pretty reasonable. There is a
slight hiss discernible from the headphone socket while there are no sounds
playing. This isn’t noticeable while playing music even at a low volume. The
speakers are adequate for system chimes, but if you plan to listen to music,
as with most laptops, the speakers are tinny and very quiet. You’d be doing
yourself a favour by investing in a nice pair of headphones.

The 14.1" widescreen display has a matte finish and is crisp and clear. It’s
very bright, and colour saturation is excellent. The viewing angle is only aver-
age, but the response time is fine for watching movies and playing games.

When one compares the resolution and higher DPI with other similarly priced
budget models from other manufacturers that are still at 1024x768, this
Aspire looks particularly impressive.

The Intel 915G graphics chipset performs well under Linux with 3-D accel-
eration supported under recent versions of X.org. Gaming performance was-
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Acer Aspire 3620
A good machine for the budget-conscious Linux user.

JES HALL

Figure 1. Acer 3620
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n’t too bad for an integrated chip, with older games like Warcraft III and
Medal of Honour: Allied Assault running well. Although this is by no means
a gaming system, the LCD response time and graphics card performance will
certainly let you play games with modest system requirements.

Wireless is provided by an onboard Broadcom 802.11g card. This chip
is similar to those used in Apple’s machines and is supported under Linux
only by either using ndiswrapper and proprietary Windows drivers or a
dangerously experimental new kernel patch. We tried both in the process
of reviewing this machine and found ndiswrapper to be the most viable
solution currently. The card has excellent range and under current versions
of ndiswrapper is very stable.

CPU frequency scaling works very well under Kubuntu. As the Celeron M
has only frequency scaling and not the voltage scaling supported by the
Pentium M, the p4clockmod driver is used. The CPU will throttle at regular
intervals all the way down to 200MHz for power saving. Dimming the
display and throttling the CPU to 800MHz extends the battery life to
close to three hours while leaving enough performance for simple tasks
like Web surfing or word processing.

General performance was pretty good. The Celeron M is a capable
chip and with the addition of extra memory, the Aspire proved itself
adequate for most tasks. This machine isn’t suitable for heavy CAD work
or very CPU-intensive tasks, but it’s just fine for most Internet, produc-
tivity and lighter graphics tasks. It compiled the 2.6.16 kernel in seven
minutes, 13 seconds with the default configuration. As a comparison,
our Athlon XP 3200+ compiled the same kernel using the same compiler
in five minutes, 11 seconds.

When one looks at the performance and features of the Aspire 3620
in context of the price, it looks like a great deal. When you add in the

very rare, almost flawless Linux power management support, it’s a lot 
of computer for the money. We can sincerely recommend this machine
to the budget-conscious Linux user, and we applaud Acer for the 
ACPI-compliant BIOS in this model. Make sure you spend the little 
extra to get more memory—it’s well worth it.�

Jes Hall is a UNIX systems consultant and KDE developer from New
Zealand. She’s passionate about helping open-source software bring
life-changing information and tools to those who would otherwise
not have them.
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� Processor: 1.5GHz Celeron M 370

� Memory: 768MB DDR2 (Max 2GB)

� Hard disk: 40GB 4200RPM

� Optical: CD-RW/DVD-ROM combo

� Graphics: Intel Extreme 915G, 128MB shared with system memory

� Display: 14.1" 1280x800 widescreen LCD

� Networking: 10/100Mbps integrated Ethernet, integrated 56k modem,
integrated 802.11b/g wireless

� Battery: 6 cell Li-Ion, 2.5 hours

� Weight: 2.35kg

� Ports: 3x USB 2.0, line in, mic, line out, VGA out, Ethernet and modem

SPECS

PROS: cheap, widescreen, great Linux support.

CONS: 256MB just doesn’t cut it, mediocre battery life.

URL: http://global.acer.com/products/notebook/as3620.htm

SUMMARY

http://global.acer.com/products/notebook/as3620.htm
http://www.tuxmagazine.com


Postal 2 is a game wrapped in controversy. If you take it for what it is—just a
game—then you can find hours of twisted fun running amok through the
beautiful setting of Paradise, Arizona; however, if you are offended by these
type of games that hold a Mature rating and don’t want your children
exposed to such violence, it would be best you did not play.

The game does hold a Mature ESRB rating, meaning that no one under
the age of 17 is supposed to purchase or play the game. Postal 2 does con-
tain profanity, drug use, murder, blood/gore, psychotic visuals and nudity; so
parents be warned. For those over 17, Postal 2 is a blast. Not merely a first-
person shooter game, Postal 2 has a story line with several built-in missions
should you choose to follow them.

INSTALLATION OF POSTAL 2
Postal 2: Share the Pain and its successor (add-on) Postal 2: Apocalypse
Weekend are available directly from the game’s creator at
http://www.gopostal.com for the very low price of $19.95 US each. Postal 2:
Share the Pain is also available for purchase through Linspire’s CNR ware-
house for $40 US or $24.95 US if a Gold Member.

If you buy the CD directly from Running With Scissors (RWS) at the above
Web site, it includes installation instructions that are fairly straightforward
and should get you up and running, though this sometimes can be a bit
intimidating for Linux newbies. A few patches are available from the Web
site as well that fix a few known bugs.

Installation/accessibility score: average

POSTAL 2’S EASE OF USE
Once the game is loaded on your Linux system, it is simply a matter of click-
ing a desktop icon to play the game. After the initial graphical presentation,
select a new game and choose your level of difficulty. There are 13 levels

from “Liebermode” to “They Hate Me”.
The default difficulty level is set at “Average”—toward the middle of the

spectrum. Once you have entered your difficulty level, you are shown a dis-
play of the relative game play keys that you can study to your heart’s con-
tent—press Start to continue. Each of these keys/commands can be cus-
tomized to your liking during the initial startup screens. The default settings

Postal 2: Share the Pain
Spend time in picture-perfect Paradise, Arizona.

JAY KRUIZENGA
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Figure 1. Opening Scene—Outstanding Graphics
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are as follows:

■ W key or up arrow: forward

■ S key or down arrow: back

■ A key or left arrow: left

■ D key or right arrow: right

■ F: show map (very important to find your bear-
ing in game)

■ E: empty hands (you don’t necessarily want to
be toting a machine gun through town)

■ C: crouch

■ Spacebar: jump

■ Q: kick

■ R: unzip/zip pants (yes, your pants—a public
display of your manhood)

■ K: commit suicide

■ G: yell “Get down!”

■ J: toggle weapon

■ Enter: use an item

■ X: drop an item

■ Right bracket: next item

■ Left bracket: previous item

■ T: quick health

■ Z: drop weapon

■ Left-mouse button: fire weapon

■ 1–0 keys: weapons (if you have them in your
possession)

That really is the most difficult task of any
game—learning the game’s keyboard/mouse con-
trol settings. The game drops subtle hints
throughout play as to what you are able to do.
For instance, if you attempt to carry a shovel into
town, the game will prompt you to press E to dis-
arm yourself as a reminder.

Game play itself is simple. You meander
through the town of Paradise, Arizona, on a mis-
sion to do certain tasks, which, once completed,
will give you an entirely different set of tasks to
accomplish. If you do not feel like playing these

DIVERSIONS
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Figure 2. Entrance to RWS (Running with Scissors)

Figure 3. Angry Protesters Soon to Turn Violent

■ Linux Kernel 2.2x or later

■ Glibc 2.1x or later

■ Pentium 1GHz+

■ 128MB of RAM

■ 3-D video card with 64MB of memory

■ XFree86 3.3x or later

■ OSS-compatible sound card

■ 8x CD-ROM

■ 1.4GB hard drive space

SYSTEM REQUIREMENTS
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missions, you can run rampant and be as
violent/destructive as you choose, though it makes
more sense to follow game play with the mis-
sions. You will have plenty of opportunities to arm
yourself as a matter of protection.

Ease of use score: good

POSTAL 2 DOCUMENTATION
The game itself is your documentation—you really
do not need more. All commands are established
by default at the beginning of the game, and
game play tells you what you are supposed to do
next. It is like a giant, psychotic soap opera in
which you are the star.

Documentation score: average

POSTAL 2 GAME PLAY—CAPABILITY
Released in April 2003, Postal 2 has been a
great success. Built upon the Unreal engine, the
game depicts beautiful scenery and graphical
displays of a busy town that has turned slightly
psycho. You are a new computer game pro-

grammer for RWS (Running with Scissors, natu-
rally) having recently relocated to beautiful
Paradise, Arizona, with your wife, to land that
dream job. It is Monday, and you find yourself
immersed in a world where nothing can go
right. You live in an old battered trailer where
the story commences. The camera pans around
the trailer while voices are heard inside—you
cussing at the non-working air-conditioner.

Distressed, you shoot the AC while your wife
nags about your job. A list on the fridge starts
off your first mission: 1) pick up your paycheck
at RWS; 2) cash your check at the bank; and 3)
pick up some milk at the store.

You exit the trailer, and your dog urinates on
your foot. Great start to your morning. Giving the
dog a kick, it yelps out of the yard. On to your
car. The hood is up, and knowing that the car is

DIVERSIONS
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Figure 4. Encounter Rude Obnoxious People

Figure 5. Looks Peaceful up Here—Bloodbath Below
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not going to start, you crank the engine anyhow. No go. Looks like you are
going to have to walk. The game begins with you peering into the open tool
shed where you see a shovel propped against the wall and a bong.

Now, you can choose to leave the shovel there or you can pick it up
(run into it) and don it as a weapon, running amok through the streets
of Paradise. If you choose the latter, the game prompts you to press E to
remind you to put your weapon away so as not to alarm the innocent
townspeople. Smoking the bong you state, “This can’t be good for me,
but I feel great.” You pay for this later when you start feeling sick.

Note: during the course of the game you will see several tunnels marked
with yellow hazard signs. These signs indicate a level change, and the game
will pause to load the new area into memory. Each time you pass through
one of these barriers, this happens, even if you already visited an area. The

game also autosaves at these points.
So, away you go on your first mission. You pass many townspeople who

are rather rude if you come anywhere near them on your way to RWS to
collect your paycheck. Once you reach your place of employment, crossing
over the path that winds up to the RWS entrance, you witness a group of
avid protesters bearing pickets and shouting, “Games are bad—they make
you mad.” Of course, you do nothing while pushing your way through the
mob, because you could care less—you need your paycheck. Inside, one of
your fellow employees stops to tell you that Vince, your boss, needs to see
you immediately. You locate Vince’s office and enter only to have Vince
waving his finger in your face mockingly explaining your plight—you’re
fired! Oh well, you pick up your check.

Outside, the crowd of protesters has gone berserk, and they rush
inside RWS bearing arms. The RWS security team has quite the shoot-
em-up firing session, which you can join given the fact that you have
collected some weapons (note: there is one sitting behind the desk in
the RWS entrance hall).

If you get out alive, be on the lookout; these protesters pop up every-
where, and they will recognize you, declaring you to be a mass killer—and
they will shoot at will.

Next, on to the bank. All you need do is cash your paycheck right?
Wrong. Inside, you must patiently wait in a long line while punks cut in and
out of line causing the poor sap in front of you to give numerous finger ges-
tures and verbal insults. After being told repeatedly to return to the back of
the line (the teller is having a bad day), you are finally allowed to cash your
paycheck. Suddenly you hear shooting. The bank is being robbed! You are
always in the wrong place at the wrong time.

We were able to walk right through the bank by allowing the cops to
shoot the thieves dead. So, on to the store to pick up some milk. There you
must pay the cashier (doesn’t know much English) and again shooting
begins. You then head home to your most ungrateful wife.

If you find yourself getting stuck, here are a few cheat codes to help you
out. To enter these codes, first press the ~ key (right next to the 1 on US
keyboards), which opens a console window. Enter the word sissy to enable
cheat mode, and then enter one of the following codes:

� alamode: God mode.

DIVERSIONS
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Figure 6. Gary Coleman Makes an Appearance
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� packnheat: arms you with every weapon.

� payload: gives you extra ammo.

� iamsolame: all three of the above—God mode, all weapons and ammo.

� jewsforjesus: extra money.

� iamthelaw: puts you in a cop uniform.

� healthful: heals your life to 100% and gives you four healthpacks.

� ifeelfree: ghost mode.

� likeabirdy: flight mode.

� resetcops(): resets police and wanted status.

Overall game play is very interesting and exciting. You can spend hours
browsing the town, engaged in meaningless missions. Just beware of the radi-
cal Islamic terrorists and the violent protestor group. They’ll pop out of
nowhere, at any time, at any place.

Capability score: excellent

GETTING SUPPORT WITH POSTAL 2
The Postal 2 Web site contains a support section where you will find more cheat
codes (hints) as well as game patches, tips on improving performance and assis-
tance with known problems. There is also a message board and forum section
where you can talk with other players to discover a solution if you are stuck.

Support: average

CONCLUSION
Postal 2 can be a riot. Take the game with a grain of salt and indulge your-
self in the storyline—you’ll either have a few chuckles or find yourself rolling
in the aisles. It is no wonder that the Postal lineage of games has amassed a
huge fan base of loyal customers eager for the next adventure to be
released. As mentioned previously, there is an add-on entitled Apocalypse
Weekend that does require the original Postal 2: Share the Pain for play. We

are certain there will be further add-ons in the years ahead considering the
game’s popularity and the demand for more twisted action.

Have fun with the game. If you are a first-person shooter fan, you will fall
in love with Postal 2. Not only do you get the action, but you also get adven-
ture. And besides, who can resist Gary Coleman (child star of Different Strokes)
right? Remember him with his infamous phrase, “what you talkin’ about
Willis”? Here he is in Paradise, Arizona, on tour for his latest book. Too bad
you’re having a bad hair day—go easy on the poor guy.�

Jay Kruizenga, a former Marine, is an accomplished Marketer (specialty:
E-Commerce), business owner and aspiring author. He has a deep love
for everything pertaining to Linux.
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Figure 7. Dead Islamic Terrorist
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